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IIIInnnnttttrrrroooodddduuuuccccttttiiiioooonnnn    ttttoooo    LLLLiiiiSSSSaaaa

WWWWhhhhaaaatttt    iiiissss    LLLLiiiiSSSSaaaa????
LiSa (Live Sampling) is a real-time audio manipulation environment that runs on any
Macintosh or Mac OS-Compatible computer with a Power PC Processor.  The program can
use either the 16-bit AD/DA converters of these platforms or any Sound Manager or ASIO
compatible audio interface.  This combination turns the Mac into a versatile audio sampling
machine.  Complete program control is possible via MIDI, allowing the user to work with this
system in performance.

LiSa was designed to fulfill the needs of musicians who work with sampled and manipulated sounds
and need more flexibility than is generally available in a traditional sampler.  Not only can sounds be
recorded and played back quickly and easily in a performance situation, LiSa’s architecture gives you
direct access to the samples in memory, allowing much more sophisticated manipulation of samples
than is possible in traditional samplers, both hardware- and software-based.  In addition, LiSa offers a
variety of algorithms for processing sampled sounds, and is very well suited for a broad variety of
delay applications.

VVVVeeeerrrrssssiiiioooonnnn    2222....5555
The 2.5 release of LiSa contains many improvements and changes over the previous releases, some
visible, and some not.  They include:

� Improved Sound Quality.  The internal sound playback algorithms
have been improved, giving better sound quality overall, especially at
lower transpositions.

� ASIO Support. LiSa now supports soundcards using ASIO drivers,
supporting up to 8 channels of input and output.

� Sample Editor.  The Sample Editor window allows for better and
more accurate placement of sounds in the Sample Buffer.

� Filters.  Playback Zone filters now have multiple modes.

� Improved GUI.  LiSa’s look has been changed, using standard Mac
windows.  The user interface has had many improvements, including
improved drag-and-drop, more consistent window management, and
better access to parameters via popup menus.

� Pitch Trackers.  LiSa can now take pitch input information and
transform it into MIDI.

� Environments Menu.  With this menu, you can store up to 9 window
arrangements, making it easier to work with LiSa’s many windows.

� MIDI Processors.  This new set of functions allows you to map
keyboard events into controller events, and vice versa

� MIDI Snapshots.  This gives you the ability to take a snapshot of
LiSa’s entire MIDI state, and allows you to use a single controller to
‘morph’ between different states.

New in
Version 2.5:

New features of particular interest to users of older versions are flagged with
the notification to the left.
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TTTThhhheeee    LLLLiiiiSSSSaaaa    IIIInnnntttteeeerrrrffffaaaacccceeee

Windows

New in v. 2.5
The entire overall look of LiSa has been changed drastically since earlier
versions.  Although they are much more like standard Macintosh windows,
there are a few differences that are worth taking a close look at for LiSa
novices and experts alike.

Lisa’s Windows are more or less like standard Macintosh windows, with the main difference that with
the exception of the Sample Editor, they cannot be resized.  Generally, you will be working with
several windows simultaneously, and there are two important things to keep in mind with LiSa’s
windows:

� All windows are active at all times.  You can directly click
and work in any open window without having to bring it to the
front first.  Generally you need to click on a window once to
activate it before you can change parameters, but this is not
the case in LiSa.

� It is nevertheless important to keep in mind which window is
topmost.  That is the window with the stripes in the title bar,
and will always be the window that you last clicked.  All edit
operations and keyboard scrolling controls affect the topmost
window.

Subdivisions of windows usually have a set of related data input controls in them, or some set of
related information.  They are called panes.
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Popup Menus and Numericals

Most of the data that you enter into LiSa’s windows
will be via either popup menus or numericals.  In
general, numericals appear as simple rectangular
boxes, and popup menus appear either as icons or
as boxes with a triangle on their bottom edge.

Using Numericals
A numerical is a box containing a number or text that can be changed from either the mouse or the
keyboard.  Values in a numerical can be changed three different ways:

� Scrolling:  Position the cursor in the box and hold down the
mouse button.  If the cursor is in the top half of the box, the
displayed values will increase; if in the bottom half, they will
decrease.  The cursor will change to an arrow to indicate the
direction of movement, and the numerical will continue to
change as long as the mouse button is held down.

� Dragging: Click anywhere in the box, hold the mouse button
down, and move the mouse forward or backward to increase
or decrease the value.  This is somewhat faster than
scrolling.

� Typing:  Click once in the box, which will select it, type, and
hit Return or Enter.

Numericals and Time descriptions
Time can be displayed in two ways in LiSa: either by seconds and milliseconds, or by number of
samples.  You can toggle between these two options by using the Show Length in
Seconds/kSamples option in the Options menu.  When viewing in seconds, you can set
time values with a precision of one millisecond.  If you need to be 100% accurate, you can
set time in samples, down to the individual sample.  A numerical can’t hold the often
gigantic numbers required for counting through a large buffer in samples, so when
displaying time in samples, they have two modes:

Note that once a
numerical is selected,

you have to deselect it
in order to change its
aspect with the shift

key.

Counting by kilobytes (kB) of samples (that’s 1024 samples, or about
.02 of a second), or by individual samples (a very tiny bit of a
second).  When you have Show Size in kSamples selected, you will
normally see time displayed in kB of samples.

If the number is in normal type, that means the time selected is an even number of kB of samples;
that is to say that the total number of samples in the numerical is evenly divisible by 1024. If it is in
bold, that means that there are samples left over – the total number of samples in the numerical is
not divisible by 1024.



LiSa v. 2.5 manual, p. 8

To fine-tune this number, press the shift key, and the number of samples left over in the numerical will
appear.  This is the fine-tune aspect of the numerical.  To change this number select the numerical
while the Shift key is depressed.  You can release the Shift key at this point, and the numerical will
remain selected.  Scroll or type as usual.

Dual Numericals

In some cases, a numerical may be used to set more than one parameter.  In these cases, mentioned
in the manual as they appear, holding down the Shift key will reveal the second parameter.  These
dual numericals are never related to precise time values, and do not relate to the situation described
above.

Editing Functions

The standard Macintosh editing functions (Cut, Copy, Paste, and Undo) are implemented in different
ways in different windows.  All numericals and text boxes in Editor windows, if selected, can be
copied and pasted into any other numerical for any other Editor.  Undo will also work normally in a
selected text box.

If no numericals in an editor window are selected, selecting Copy will copy the entire data structure
(Envelope, Zone, whatever) to the clipboard.  This can then be pasted into a new structure of the
same type.  All parameters, including the name, will be copied over.

The Environments menu

New in v. 2.5:
Environments

When working with LiSa, with its plethora of windows, it can get a bit
annoying to constantly be navigating between large numbers of open
windows.  Often, while working on one particular aspect of your
Setup, such as sample editing, you will need one set of windows
open, but another for setting MIDI connections.  The Environments
menu is designed to ease your work in this respect.  Each Preset
can have up to 9 environments.

When you create a new Environment, LiSa will remember which windows are open, and their position
on your screen.  You can create up to nine environments for each of your preferred work situations.
Environments are saved with your Setup.

Menu Functions:

New Environment.  Memorizes the current window arrangement,
and adds a new Environment to the menu.

Replace Current Environment.  The window arrangement of the
current Environment will be replaced by the current on-screen
window arrangement.  Each Preset can have its own Current
Environment, as well as a set of 9.

Environment  <n>.  Selects a new Environment.  The currently
selected Environment will be bulleted.

FFFFuuuunnnnddddaaaammmmeeeennnnttttaaaallllssss    ooooffff    LLLLiiiiSSSSaaaa

Overall Structure

LiSa’s general architecture is divided into Setups, Presets, and Zones.  Data that LiSa uses is stored
in Libraries.  The file you load when you start up a program is a Setup.  Each Setup is comprised of
up to 128 Presets, which are the immediate sound and control environments you work in when editing
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or performing with LiSa.  A Preset is comprised of up to 2048 Zones, which contain all the actual
information regarding sample performance and manipulation, plus a set of MIDI controller and
keyboard connections to direct how MIDI will affect your sounds.

Sound in the Computer

LiSa, like all samplers, works by loading sounds into a contiguous chunk of RAM, known as a buffer.
The key difference between LiSa and traditional samplers is that you have direct access to all parts of
the Sample Buffer via MIDI.  All sounds loaded into LiSa are stored in one large buffer; one sound
lined up after the other.

You access this buffer by creating Zones.  A Zone is
comprised of three aspects: A keyrange (or range),
a function, and a sample region, or region.  Zones
are activated (played) by MIDI ‘note on’ messages.

� The range is the key or keys (MIDI notes) that activate the
Zone.  These are specified in the Assignment Window.  The
same Zone can be assigned to different keyranges in
different MIDI channels.

� The sample region is the physical area of the Sample Buffer
on which the Zone operates.  It can be all or part of the
buffer, and its exact size and location can be either set
permanently or controlled via MIDI.  These initial parameters
are set in the Zone Editor window.

� A function is what the Zone does to the Zone’s region.
Playing back, recording, and loading sounds from disk are all
examples of functions.

When a Zone receives a note on message in its keyrange, it does its thing, whatever that may be.  A
typical Preset would be comprised of some number of Zones for playback, recording sounds live, and
loading samples from disk.

Libraries

All of the data LiSa uses in a Setup – Zones,
samples, tables, and so on, are stored in a set of
Libraries.  They are independent data banks, and
can be shared between Setups.
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The Assignment Window

The Assignment window provides you with the basic information about your Preset, the actual
‘instrument’ you work with at any given moment.

In the title bar of the window, you can see the name of the currently loaded Setup – this is your open
file.  The two numericals at the top of the window contain the name and number of your currently
loaded Preset.  Every Preset has both a name and a number, which is the number of the Program
Change Message that loads it.  A Setup can contain up to 128 Presets.

Below, with the keyboard inside, is the Zone Assignment pane.  Here is where you assign Zones to a
keyrange for activation, and assign MIDI channels.

At the bottom of the window is the Parameter Control pane.  This is your ‘patchbay’ for MIDI and
internal modulation control.

Each Preset is comprised of up to 16 Voice Layers (see Voice Layers and MIDI Channels, p. 85),
indicated by the row of numbered buttons above the keyboard.  Each Voice Layer can respond to a
different MIDI channel, and have a different set of key assignments and Parameter Control options.
When nothing is selected in the Assignment Window, selecting Copy from the Edit menu will copy
the entire Voice Layer to the clipboard, from which it can be pasted into a Voice Layer in the same, or
another, Preset.
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The Zone Editor

The Zone Editor is one of the most important parts of LiSa.  It is the window in which you determine
both the function and the sample region of a Zone.  Its exact appearance will vary depending on the
kind of Zone that you are editing.

As in the assignment window, you can see the name and number of the Zone on top.  Unlike Presets,
these numbers have no particular meaning – they are LiSa’s catalog numbers.

To the right of the Zone name is a row of icons.  When clicked, they reveal a series of popup menus,
which determine the function of the Zone (record, playback, etc.) and the modes of that function.  A
Zone that plays a sample backwards has the same function (Playback) as one that plays it forwards,
but with a different mode.

The Region pane is where the sample region of the Zone is set.  In some functions this pane will
include other options such as tuning.  These parameters are usually MIDI controllable.

The Treatment pane contains parameters specific to the Zone’s function, and the parameters
available can change a great deal depending on the function of the Zone.  It can contain such things
as input and output levels, processing parameters such as distortion, or the name of a file to be
loaded.

The Status Window

This is the main window for performance and real-time information.  It is dominated by the Sample
Buffer pane, which shows the sounds you are working with.  It also shows current MIDI input,
processor load, and other miscellaneous information.
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The Sample Editor

The Sample Editor window is where you can design your selection of samples for use in
performance.  Samples can be dragged to the Editor from the Sample Library, edited, and resaved to
your hard drive as new samples.

Libraries and Editors

All of the data used in LiSa is stored in Libraries: Zones,
Envelopes, Tables, Controllers, Patterns, MIDI Processes
and Snapshots, and Samples.  We have already
encountered the Zone and Sample editors, and the others
will be explained in future chapters.  Double-clicking on an
item in a Library will open up the associated editor, or you
can open the editors from the Windows menu.
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SSSSeeeettttttttiiiinnnngggg    uuuupppp    LLLLiiiiSSSSaaaa

HHHHaaaarrrrddddwwwwaaaarrrreeee
LiSa will run on all desktop and laptop Macintosh PowerPC computers that have a G3 or G4 processor.
On older systems, LiSa may work very slowly or not at all. An external MIDI interface is also required
for connection to your keyboard or other MIDI controller.  This can be connected to the USB port, or, on
older machines, either the modem or the printer port.

To take full advantage of LiSa, it is also necessary to have some kind of MIDI instrument.  In this
manual we will assume you have a velocity-sensitive keyboard with pitchbend, a modulation wheel,
and aftertouch.

Memory

LiSa requires at least 16 MB of RAM to operate, so a total of at least 64 MB of RAM is recommended
for your computer.  The sounds used by LiSa are stored in RAM, so the more RAM you have available
above and beyond that, the longer your Sample Buffer can be.

Recommended memory assignment (in the Information panel for LiSa) is 40875 kB.  Memory you
assign to LiSa’s buffers will also be included in this number, so it needs to be fairly large.  For every
additional MB of RAM you assign to LiSa, you will increase your available buffer space by
approximately 6 seconds.  If you have assigned more memory to LiSa than your machine has
available, you will probably get a dialog at startup indicating that OMS is not installed.  This is because
LiSa eats the memory that OMS would normally take, and once LiSa has opened, OMS can’t find the
memory it needs.  If you get this warning and know you’ve installed OMS, quit LiSa.  Select it in the
finder, and choose Get Info... from the Special Menu in the Finder.  From there, you can resize the
memory to a lower value in the Information panel, and open it up again.  If that does not help, open the
Preferences folder in your computer’s System folder and throw away the file ‘LiSa Prefs’.

SSSSyyyysssstttteeeemmmm    sssseeeettttttttiiiinnnnggggssss    aaaannnndddd    AAAAuuuuddddiiiioooo    DDDDrrrriiiivvvveeeerrrrssss
LiSa is compatible with Mac OS 8.1 to 9.2.2 for Power PC; however, make sure that Sound Manager
version 3.3 or higher is installed regardless of your hardware or system version.

Check your ‘Memory’ control panel. Virtual memory should be off.

AAAAuuuuddddiiiioooo    SSSSeeeettttuuuupppp

New In v. 2.5: LiSa
now operates

entirely in stereo.

Lisa has undergone two major transformations in
its audio handling:  It now operates entirely in
stereo, both input and output, and it also
supports third-party audio hardware which uses
either ASIO or Sound Manager drivers.  Setup for
both systems is described below

Installing ASIO Drivers

If you have an audio card that uses ASIO drivers, they must be installed in the LiSa folder in order for
the program to use the card.  All ASIO drivers for your hardware should be installed in a folder called
‘ASIO Drivers’ (without the quotes) in the same folder as the LiSa application.
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Selecting your Audio Drivers

To select hardware for audio input and output, go
to the new Audio Driver… item in the Global
menu.  If you are using either the hardware built
in to your Mac, or have a third-party audio card
that uses Sound Manager drivers, select Sound
Manager.  If you have installed ASIO drivers into
your LiSa folder, a list of the available drivers will
appear in a submenu under the ASIO settings.  If
for some reason LiSa is unable to open the ASIO
driver, this setting will revert to Sound Manager.

Configuring Audio I/O

Once you have selected your audio drivers, you
can configure them in the Audio Setup dialog
(also found in the Global menu).

The Driver pane indicates which kind of drivers
you are using.  You cannot change your driver in
this window – you must use the Audio Driver
menu item shown above!

The Input and Output panes are where you
assign specific physical inputs and outputs on
your soundcard to channels in LiSa.  If you have
ASIO installed, each playback or record Zone
can be assigned to a lettered left/right pair.  For
determining input and output assignments in
Zones, see p. 69

Sample Vector Size: Expressed in samples, this
parameter determines the number of samples
processed in a single block by LiSa.  This setting
has a great deal of influence over the overall
behavior of LiSa.  For more detail on the
relationship between sample vector size and
Lisa’s response, see Appendix A.  If you are
using an ASIO device, you cannot change the
Sample Vector Size in LiSa.  It must be done
through the device’s Control Panel, which you
can open by clicking on the Control Panel button
in this window.

Input

Whatever your sound source is, it is important to run your input through some kind of a preamp or
mixer in order to be able to set your levels properly.  You can set an overall level for recording input in
the System Settings dialog, see p. 16.
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When you have audio input, you should see some
activity in the input level meter at the bottom center
of the Status window, and on the far right side of the
Sample Editor. (The Sample Editor only shows
sound routed through input pair A)  The recording
input bar is split left/right for each lettered input pair.
If you are using ASIO, each Record Zone can be set
to record from a different lettered left/right pair, see
p. 69.  Set your mixer levels so that the input level
meter is as high as possible without going into the
red.

Output

If you are using the Sound Manager and the hardware outputs on your computer, just take both of the
outputs from your Mac and send them to a mixer.  If you are using ASIO, plug in as many outputs as
you are using into your mixer.  For assigning playback Zones to specific output pairs, see p. 56

MMMMIIIIDDDDIIII    SSSSeeeettttuuuupppp

Connecting MIDI

LiSa needs MIDI input to take full advantage of its capabilities.  (Some MIDI may also be generated
from the computer keyboard and the mouse – see p. 101.)  You will need a MIDI interface, and OMS,
preferably at least version 2.2.  Plug your interface into your computer’s USB or serial port, and the
MIDI out from your controller into the MIDI in plug of the interface.

Configuring MIDI

In order for your MIDI instrument to properly
communicate with LiSa, you need to specify
which ports are in use for MIDI.  This is done in
the MIDI Setup... dialog in the Global menu.
There you can select both input and output
devices from your OMS setup. Note that when
Midi Thru is selected not only the external
incoming MIDI is sent thru to the selected output
but also the internally generated MIDI, such as
Key Map note events and Mouse Control events.

Preferences (the Global menu)

Preference settings for LiSa are found in the Global menu. They are stored in each individual Setup.
This means that for each LiSa Setup you have, you can have completely different set of preferences.
A new Setup will start with the preferences from the last Setup opened.

LiSa Settings

Global settings may be found in the LiSa Settings… item in the Global menu.  It is divided into three
sections:
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MIDI Settings

In this section, you can set MIDI for commands to
LiSa’s system.

System Channel.  This is the channel on which you make
commands to LiSa’s system, independent of Zone activation
and other performance-related commands.

Output Buffer Rec. Start.  Any value sent on the selected controller
number on the System Channel will initiate Output Buffer
recording.  To find out what this means, see Copying
Buffers, p. 81.

Amplify Current Zone.  Any value sent on the selected controller
number on the System Channel will amplify the Region of the
currently active Zone by the value specified in the %Gain
numerical.  This is described further under the heading
Amplify Current Zone, page 96.

LiSa Volume.  This controller number on the system channel will
control the overall volume of all of LiSa’s output.  Any other
volume settings will be relative to the LiSa volume.

Clear Sample buffer.  Any value sent on this controller number will
clear all audio from the sample buffer.

System Settings

� 

Max Voices .  LiSa will tend to demand as much of your computer’s
processor time as it needs to perform its assigned tasks.
This can cause two problems:

Earlier versions of LiSa
expressed this as a

percentage of total CPU
load.  As this could still

lead to occasional
freezes in certain

situations, it has been
replaced with maximum

� If you are attempting to run LiSa in tandem with other
applications on your computer LiSa can easily freeze them
out.  (The Status Window provides you with a running display
of how much of your computer’s CPU time is being used by
LiSa.)

� If you attempt to play more voices than your CPU is capable
of generating, you can lose some audio, or even freeze the
machine itself.
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number of voices

This numerical sets the maximum number of voices LiSa will play.  If
more Zones are activated than there are assigned voices, LiSa will
automatically drop the oldest active voices in order to keep the total
below the number set in Max. Voices.  The best setting will depend
on your machine and what kind of playback modes, filtering and
playback quality you use in your Setup, as well as what other
applications you may be running at the same time.  The best way to
find the optimal value is simply to experiment.

Recording Input Gain.  Overall attenuation of your input signal to
the Macintosh’s analog/digital converters can also be set
here.  This numerical has a range of 50% - 150% of the
original input level.   Normally it should be set to 100%.

Rel. Start Range.  This value determines the percentage of a Zone
that is affected by the Rel. Start parameter.  For a full
explanation, see Sample movement parameters on p.89.

Crossfades.  The number in this numerical sets the number of
samples used in those crossfades in which you have real
time control, such as Absolute start time. The smaller the
crossfade, the clickier your transitions will be, but the less
CPU time you will use. This value will also control the size of
the crossfades used when loading, cutting or pasting,
samples into the Sample Editor.

Envelope Followers

LiSa can translate its audio input into MIDI, which
can be used as controls for Zone parameters.  (See
Envelope Followers on p. 96for more on this topic).
The Envelope Followers track amplitude variations in
the audio input.  Note that the settings below can be
separated for both left and right inputs.

EF Channel.  The MIDI channel on which the Envelope Followers
will send data.

EF Note Number.  The MIDI note number that will be activated when
the Threshold is exceeded.

EF Threshold.  The relative amplitude value at which a MIDI note on
will be triggered.

EF Contr. Nr.  The Controller number that will follow the amplitude
envelope of the incoming signal.
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Enable/Disable.  This numerical controls the functionality of the
Envelope Followers.

Pitch Trackers

LiSa can also detect input pitch, and translate it into
MIDI events.  For a further explanation of pitch
trackers, see p. 97.  Note that these are also
separated into left and right inputs.

Channel.  The MIDI channel on which Pitch Trackers send MIDI
data.

Event.  Here you can choose what kind of MIDI event the Pitch
Trackers will generate.

Frq. Min.  The lowest frequency to which the Pitch Tracker will
respond.

Enable/Disable.  This numerical controls the functionality of the
Pitch Trackers. Controller values are automatically scaled between
the min and max values.

Meta Control

These parameters set the control input for LiSa’s new Meta Controls, which give you control over many
control parameters simultaneously.  These setting will be confusing until you read the chapter on MIDI
Snapshots on p. 104 for a full description.

� 

Meta Channel.  Controllers or notes sent on this MIDI channel will
affect the Meta Controllers.

Control X/Y.  These two controllers will set the x and y axes of the
Meta Controller.
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Inv.  If this box is checked, the control input will be inverted.  An input
of 0 will be read as 127, and vice versa.

Snap Triggers.  If LiSa receives one of these 4 notes, it will ‘snap’ all
Meta Controller settings to one of the four corner positions.

Size of Buffers

The Sample Buffer is the part of your computer’s
RAM that is assigned to storing the samples you
play in LiSa.  It can be as large as your computer’s
memory allows, but you must assign the memory
space in the Get Info... dialog in the Finder.  (see
Memory on p. 13) There are actually 3 buffers in
LiSa, and each of them can be set individually
through the Size of Buffers… dialog in the Global
menu.  The size of these buffers can be set either
in seconds or kilobytes of memory, depending on
whether the View Size in Samples option is
selected in the Options menu.

Sample.  This is the buffer that actually holds the samples you work
with, and is represented in the Status window.  This is LiSa’s
main workspace, and the most important of the three buffers.

Output.  The Output Buffer records whatever you have played most
recently, including your silences.  You can save this buffer to
a soundfile in order to listen back to what you have just
played, or for further processing later.  It does not
automatically record; it has to be activated via MIDI, or by
hitting the ‘S’ key on your Mac’s keyboard.
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Process.  The Process Buffer holds the last piece of sound you
produced.  If you play for a minute, and then don’t play for ten,
that minute (or however long, depending on your buffer size)
will still be in the buffer.  This buffer is specifically designed for
resampling something you have already played in a live
situation (for more on these two buffers and their functions,
see Copying Buffers on p. 81).  It’s best to think of the
Output Buffer for saving or editing sounds at a later time, and
the Process Buffer as a tool for live performance.

Pitch Bend Range

In this dialog, you can set the pitch bend range for
your Setup.

Keyboard Map

If you want to use your Mac’s keyboard to send
MIDI note events to Lisa, here is where you can
decide which keys activate which notes.  See
Controlling LiSa from the Computer on p. 101 for
more on how to use this feature.

IIIImmmmppppoooorrrrttttiiiinnnngggg    oooollllddddeeeerrrr    LLLLiiiiSSSSaaaa    ffffiiiilllleeeessss
LiSa 2.5 uses a different file format from earlier versions, and Setups created in earlier versions need to
be converted for them to work properly.  Due to the nature of many of the changes, not all of your old
settings will be converted properly.

To import a Setup from an earlier version, simply open it up in LiSa 2.5.  You will see a dialog asking if
you want to convert the old Setup to v. 2.5.  The setup will be opened, with the parameters adjusted as
well as possible to the new version.  You will probably get some memory warnings.  Since LiSa is now
stereo, it uses twice as much memory per second of samples in the buffer.  The parameters you will
have to pay the most attention to will be your modulator speeds and envelope timings, as the new
floating-point timings and variable sample vector size may change these parameters considerably.

The most significant change is the disappearance of Autopan Zones.  These will be saved as ordinary
Play Forward Zones.  To get their behavior to imitate the old functionality, use a modulator controlling
the Pan parameter, and have the MIDI note number controlling the speed of the modulator.

Once you have adjusted your converted Setup, selecting Save… will bring up a Save As dialog box, so
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you can save your converted Setup with a new name.  This will keep you from overwriting your older
version.
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ZZZZoooonnnneeeessss

Zones are the primary link between the performer and the sound material.  All actions in LiSa are
initiated through Zones.  They define all the methods and details for user interaction.  It is important
to familiarize yourself with some basic ideas about Zones and procedures for editing them, or you
will quickly get lost further on.

SSSSttttrrrruuuuccccttttuuuurrrreeee    ooooffff    aaaa    ZZZZoooonnnneeee
A Zone can be thought of as the link between the keyboard (or other MIDI input) and the Sample
Buffer.  Playing notes on the keyboard can initiate all the basic activities of recording and playback,
loading and saving soundfiles, and most other real-time actions LiSa performs.  There are 3 basic
elements to a Zone:

� Keyrange, or range.  This is the key or keys that activate the Zone, i.e., tell it when to start
or stop.  Zones may respond to any MIDI note in the range 0 - 120 (c-3 to c10), on all 16
MIDI channels.  Any one Zone can be activated by any number of keyranges on different
MIDI channels.

� Function.  A function is what the Zone actually does -- record a sample, play it back, or
load or save from disk.  Each function has further sets of options called modes.

� Sample Region, or region.  This is the segment of the Sample Buffer on which the Zone
operates.  It can be any size within the limits of the buffer, and can be resized and moved
via MIDI.

Zones, like all other data in LiSa, exist independently of any individual Setup, and are saved in
Library files.  Different Setups can use the same Zones by using the same Zone Library.  When you
save a new Setup, the Library will automatically be named with the Setup, but it is now a separate
file, and can be loaded into any Setup you wish.  For more on loading and saving Libraries, see
Libraries, page 33.

All the Zones for a Setup are stored in one
Library.  Each Library can hold a maximum
of 2048 Zones.  Double-clicking on a Zone in
the Library makes it appear in the Zone
Editor window.  Zones can be cut, copied,
pasted or duplicated in the Zone Library.  If
you want to make a duplicate of a Zone (for
example to create a Zone that is a slight
variation of another Zone) you can select a
Zone in the Library, and select Duplicate
from the Edit menu, or press Cmd-D. A new
Zone will appear with the old Zone’s name
plus a star (*).  If a Zone is assigned to a key
somewhere in your Setup, a bullet will
appear in front of the Zone’s name in the
Library window, so you can immediately see
which Zones in the Library are in use.  The
bullet marks will only be updated when you
store the current Preset.

Each Zone listed in the Zone Library has a
one-letter prefix indicating its type:

 p: Play
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 r: Record
l: Static Load

d: Dynamic Load
c: Copy Buffer

CCCCrrrreeeeaaaattttiiiinnnngggg    aaaa    ZZZZoooonnnneeee
All Zones are created in the same way, regardless of their function.  In the upper-right-hand corner
of the Zone Library window is a button marked New.  Click on this button, and a new Zone will
appear listed in the Library.  It will also appear in the Zone Editor with some sexy name like ‘Zone Nr
13.’  All Zones begin life as Playback Zones, and it is in the Zone Editor that you can change its
function, set its parameters, and rename it.

TTTThhhheeee    ZZZZoooonnnneeee    EEEEddddiiiittttoooorrrr

The illustration above shows the Zone Editor, as it appears when a Fresh Zone is created.  This is
the window for a Playback Zone.  Both the function icon and the title below it display the Zone’s
function.  If you change the function of a Zone, changes will appear in the window layout.  These will
be discussed in greater detail in their respective sections.

The Zone information Pane
The top pane of the window contains the most basic information about the Zone:

Number.  This numerical shows the catalog number
of the Zone.  Zones are numbered
sequentially in the order of their creation.
This number is LiSa’s internal reference to
the Zone, and cannot be changed.  In order
to edit a Zone, you may use the Zone
Number numerical to select the Zone of
your choice, or double-click on the Zone’s
name in the Zone Library.  When the Zone
editor is topmost, you can cycle through
available Zones in the Zone editor by using
the left and right arrow keys.

Name.  In this box (which is not a numerical) you
can rename the Zone.  Clicking in it once
selects the whole box, and you type the
name in.  Zone names may be up to 15
characters long.  To move the cursor in the
Name box hold the mouse button down for
a second when you click in it, and the cursor
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will appear.  You can then move it around
with the arrow keys.  Hitting Enter will make
the new name appear in the Zone Library.

Output.  This numerical is only visible when you
have a soundcard with multiple outputs in
your computer, and have installed the
appropriate ASIO drivers.  Here is where
you choose which lettered stereo pair the
Zone will send its output to.   For configuring
output, see p. 14.

Function Button.  This button, just left of the name,
above the label Play in the picture above,
determines the function of the Zone.
Clicking on this button brings up a popup
menu, from which you can select a function.
Once this is selected, the name of the
function will appear below the icon, and the
window will be reconfigured for that
particular type of Zone.

Mode Buttons.  The buttons to the right of the
Function button vary in number depending
on the Zone’s function, and control various
parameters relating to the Zone -- we’ll look
at these in more detail in the chapters on
the specific Zone functions.
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The Region Pane

In this section, the bottom left part of the
editor, the sample region, movement range,
and tuning for the Zone are set.  See Defining
Sample Regions, page 26 for more details.

The Function Pane

This pane contains information specific to the
function of the Zone being edited, and varies
the most from one function and mode to
another.  As this image is taken from a
Playback Zone, it is in here called the Play
Treatment pane.

SSSSeeeettttttttiiiinnnngggg    KKKKeeeeyyyyrrrraaaannnnggggeeeessss

To assign Zones to MIDI note events, you need to open the Assignment window from the Windows
menu.  This window has the current Setup’s name as the window title, so initially its title will be
‘Untitled Setup’.

The Assignment window is divided into three parts.  Here we will be primarily discussing its
relationship to creating and applying Zones.  For its other functions, see the chapters Presets,
Setups, and Libraries  on p. 29, and Parameter Control on p. 84.

  The Zone Assignment pane of the Assignment window has two parts to it, a row of buttons
(actually popup menus) labeled Voice Layers, and a representation of a keyboard.  The Voice
Layer buttons indicate which Voice Layer is currently being shown in the keyboard below.  Each
Voice Layer responds to a particular MIDI channel.  (For a full explanation of Voice Layers and MIDI
channels, see the chapter on Parameter Control.  In a new Setup each of the 16 Voice Layers is
assigned to MIDI channels 1-16.

Keep in mind that the keyrange of your
Zone indicates your access to it only, and is

in no way connected to how much of the
buffer it reads.  Keyrange assignments &

sample region assignments are wholly
unrelated

The keyboard itself represents MIDI note on
events, from 0 to 120.  The numbers below the
keyboard indicate the MIDI note numbers of the
keys.  As most keyboards cover the range of MIDI
notes from 36 to 96 (c1-c6), that is the default for
the visible range.  You can see lower or higher
notes on the keyboard by clicking on the arrow

Keep in mind that the
keyrange of your Zone

indicates your  access to it
only, and is in no way



LiSa v. 2.5 manual, p. 26

buttons above the keyboard on the right- and left-hand sides, which will move the visible section of the
keyboard an octave at a time.  It is on the keyboard that you assign Zones to virtual keys.  This
determines which MIDI note on events will activate which Zones.  A Zone can occupy as much or as
little of the keyboard as you like, although it is usually unnecessary for Record or Load Zones to occupy
more than one key.  The one exception to this is Load Session Zones p. 79.

Deleting a keyrange
To remove a keyrange entirely from the virtual keyboard, click-drag an unassigned (uncolored) key
over the keyrange.  Assigning a new Zone to the lowest key of a keyrange will also delete that entire
range from the keyboard.  If the keyrange is trapped between two other ranges you don’t want to
change, you can clear an individual key by Cmd-clicking on any key in the unwanted Zone.  From
there you can drag the unassigned keys over the rest of the unwanted Zone.

Finding Zones
Once you have created a large number of Zones in a Setup, it’s not hard to lose track of them.  To
find out if a Zone is used in your Setup, check in the Zone Library window. If there is a bullet in front
of its name, it is in use in the Setup.  (These will only be updated when the Preset is stored).

Warning:  When Finding a Zone, LiSa will
load the entire Preset, including a new

sample into the buffer if there is one, so
make sure you’ve saved all changes to the
Preset you’re working on before you Find a

Zone.

To find out where a Zone is in your Setup, select
the Zone you are looking for in the Zone Library,
and choose Find Selected Zone from the Edit
menu, or press Cmd-F.  LiSa will then locate the
Zone, load the Preset that it is in, and flash the
lowest key of the Zone in the virtual keyboard.  If
it is loaded into more than one place, Find Zone
Again (Cmd-G) will locate its next appearance.

DDDDeeeeffffiiiinnnniiiinnnngggg    SSSSaaaammmmpppplllleeee    RRRReeeeggggiiiioooonnnnssss
There are two ways to define a sample region: either using the numericals in the Region pane of the
Zone Editor, or by directly applying values from the Sample Editor.  The sample region you define
will be visible in the Sample Buffer pane as a segment the same color as the keyrange in the
Assignment window.

Sizing regions from the Zone Editor

The Region pane of the Zone Editor,
regardless of the function of the region, will
always contain the two numericals below:

Stt.  Start of region.  This sets how far into the
buffer the Zone begins.

Len. Length.  This determines the length of the
region, how broad an area within the buffer
the Zone uses when activated.

To the right of each of these numericals is a box labeled CTab.  These are part of the Parameter
Control implementation, and will be described in full in Mapping MIDI Controllers – CTabs on p. 93.

Sizing Regions from the Sample Editor
Instead of defining the start and length of your Zone’s view by changing the Stt and Len numericals,
you can also do it directly in the buffer, by selecting parts of the buffer and then applying them to the
Zone currently being edited.  These operations are performed in the Sample Editor window.
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To apply a selection in the Sample Editor to the current Zone:

Click-drag through the portion of the buffer you wish to select.  The
start and length values will appear in the numericals labeled
section at the top of the window, and the selected region will
be highlighted.  Select Enter Selection in Zone from the
Edit menu, or press Cmd-E.  The selected region will then
become the Zone’s sample region.

Select the portion of the Sample Buffer you wish to use, and drag it to
the Sample Editor window.  The Zone currently visible in the
editor will resize appropriately.

You can nudge the start point and length of the region by holding down the Option key and pressing
the arrow keys on your computer keyboard.  It nudges in increments of 1 kB of samples.

The key commands will only change the
region size if there is no selected area in
the sample editor.  If part of the sample

editor is highlighted, then they will change
the size of the selected area, not the region.

� Option-Arrow left will move the start point
earlier in the Sample Buffer (i.e., to the left).

� Option-Arrow right will move the start
point later in the buffer (to the right).

� Option-Arrow up will increase the length
of the region.

� Option-Arrow down will decrease the
length of the region.

ZZZZoooonnnneeee    FFFFuuuunnnnccccttttiiiioooonnnnssss
Each Zone has a function, which can be can be changed using the Function button in the Zone
Editor window, the first of the row of icons in the top-right of the Zone Editor.  Here the general
function options of Zones are described.  Specific modes for each of these functions are discussed
in the following chapters.

Playback.  Activating a Playback Zone will play
back all or some part of the Sample
Buffer.  Each Playback Zone can be
individually tuned as far as which area of
the buffer it will play, and how it will play
it.

Record.  Activating this Zone will cause some
part of the Sample Buffer to be
overwritten with new sounds from a live
source, and optionally saved to disk.

Load Sample. Static and Dynamic Load Sample
Zones load soundfiles from disk into the
Sample Buffer, which can then be used
by Playback Zones.

Copy Buffer.  This Zone resamples your own
output from LiSa after it has gone through
some kind of transformation, and puts it
back into the Sample Buffer to be played
again.
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Load Session.  A Load Session Zone is a special
bank of Load Sample Zones, designed
especially for retrieving live recorded
samples created during a performance.

All Zones have certain parameters in common, and others that are unique to their function.  These
parameters are initially defined when the Zone is created in the Zone Editor.  Most of them are also
controllable in real time via MIDI or internal modulators.  Connections between MIDI control and
Zone parameters are made in the Assignment window, described in Parameter Control, p. 84.
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PPPPrrrreeeesssseeeettttssss,,,,     SSSSeeeettttuuuuppppssss,,,,     aaaannnndddd

LLLLiiiibbbbrrrraaaarrrriiiieeeessss

Above Zones in LiSa’s overall architecture are Presets and Setups.  The file you load when you start
up the program is called a Setup.  Every Setup is comprised of up to 128 Presets, which you can
switch between in performance using MIDI Program Change messages.  A Preset is what you are
actually working with at any one time when programming or performing with LiSa.

PPPPrrrreeeesssseeeettttssss
A Preset is the basic performance unit of LiSa.  When performing or editing, you work with only one
Preset at a time.  A Preset is comprised of two parts: Up to 1920 Zones, organized into a maximum of
16 Voice Layers (see p.  85), and an optional sample to be loaded into the Sample Buffer with the
Preset.  You access Presets through the Preset Window, where you can also set parameters for initial
sample loading and playback quality.

The Preset Window

The Preset window is where you can find basic information about the Presets in your Setup.  It
resembles, but is not identical to, the Library windows we have encountered so far.  It is available in
the Windows menu, or by pressing Cmd-Opt-1.

Note that unlike Libraries, there is no
particular need to create Presets in
numerical order.  Since Presets are
accessed via MIDI program change

messages in performance, you can ‘fill’
any empty Preset you wish to match

any program change numbers you
choose

Unlike Library windows, there are already 128
Presets in the Preset window.  A new Setup
will have one Preset already made, called Init
Preset.  The other Presets, although visible,
are empty, and have not yet been initialized.

Creating and Copying Presets

To create a new Preset:
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� Double-click on an empty Preset in the Preset window.
You will get a dialog asking you if you want to create a new
Preset.  Clicking ‘OK’ will automatically create and load it.

� Select an empty Preset and then select Load Preset in the
Presets menu.  The same dialog box will appear.

To copy a Preset:

� Select Store Current Preset As…. From the Preset menu.
You will then be given the option of which position you want
to store the copied Preset into.

Once the new Preset is created, you can rename it in the Assignment window.  This new name will not
be reflected in the Preset window until you store the Preset using either the menu item Store Current
Preset or Store Current Preset As…  Using the former will store it in its current position, and the
latter will allow you to set its number, and thus the number of the Program Change message that will
load it.

Deleting and Clearing Presets

An ‘Empty Preset’ as seen in the Preset window takes up no space on your hard disk.  If you decide
you don’t need a Preset or want to start from scratch, there are two menu options available, both in the
Preset menu:

Clear Current Preset.  Whatever Preset is
currently visible in the Assignment window
will be cleared.  All Zones will be removed,
and all MIDI connections broken.  Libraries
will be left untouched -- any Zones,
Envelopes or Patterns you have created,
even if they’re not used anywhere else, will
not be deleted.  Memory allocation will not
change, and the 34K of memory the Preset
occupies will still be occupied.

Presets and Memory:
 It is important to note that

every time you create a new
Preset, your Setup file will

increase in size by 34
Kbytes, even if there is

nothing in it.  A Setup
containing the maximum

possible number of Presets
will thus be almost 4 MB.

Thus it is advisable to use
the minimum possible

number of Presets, and to
make sure that any created

Presets are actually being
used.

Delete Selected Preset.  Selecting this item will
completely delete the Preset selected in the
Preset window.  Libraries will still remain,
but the memory the selected Preset
occupies will be cleared.  It is not possible to
delete the currently active Preset.  To delete
a Preset, you must select another one and
then delete the unwanted Preset.

Viewing and Editing Presets

To load a Preset into the Assignment window:

Click on the Preset Number numerical at the top of the Assignment
window.  This works identically to the Zone Number
numerical in the Zone editor.  You can scroll to or type in the
number of the desired Preset.

When the Preset number
appears in Bold in the

Assignment window, that
means it has unstored

changes.

Press the up or down arrow keys.  (This will scroll between
created Presets only.).  The up arrow key will give you the
next higher numbered Preset, and the down arrow key the
next lower one.  The selected Preset will change only in the
Assignment window -- you will not see the selected Preset
change in the Preset Window.  For this to work, the Preset
window must be topmost.



LiSa v. 2.5 manual, p. 31

Click on a Preset in the Preset window, and select Load Selected
Preset from the Preset menu.  Double-clicking on the Preset
will do the same thing.

Preset Options

Loading samples with a Preset

When you load a new Preset, you have the
option to load a sample with it.  To choose a
sample from disk to load, select the sample from
the Sample Library and drag it to the Sample
column of the selected Preset in the Preset
window. The selected sample will always load
from the beginning of the Sample Buffer.

There are five loading options for Preset Images; each represented by a different symbol in the Load
column in the Preset window.  Clicking on one of these will bring up a pop-up menu with the options
below.  In all of them except Clear Buffer, the effected area is limited to the region of the buffer into
which the new sample is loaded.

-- No Load.  No sample will be loaded.

• Replace.  In this mode, the new sample will completely
replace whatever was in the region.  Parts of the Sample
Buffer beyond the original sample will remain untouched.

Ø Insert.  Any silences currently in the effected region will be
filled with sound from the loaded sample.  The new sample
is layered directly on top of the old buffer.  For example, if
samples 500-800 of the buffer are empty when a sample in
this Mode is loaded, samples 500-800 of the new sample will
go into the empty space.  If some or all of the new sample is
silence, that will be loaded as well.

º Mask. This is the inverse of Insert.  The entire new sample
will be loaded, but any silences that may be in the new
sample will not erase what was already in the buffer.  New
samples will replace old samples, but silences will leave old
samples untouched.

X Clear buffer.  All samples in the entire Sample Buffer will be
cleared.

Playback Quality

To the far right of the Preset window is the Preset
Options column.  This will affect the quality of
playback of the Preset.  It is possible to select
between two different sample rates for playback,
Good and Best.  Presets assigned to Good will play
back their samples at a rate of 22.05 kHz, and Best at
44.1 kHz.

If you are using an ASIO
audio device with LiSa, the

good playback option will
not be available, and all

samples will be played back

It is also possible to enable or disable sample
recording.  When sample recording is disabled, more
voices will be available, especially on slower
machines.  If a Preset is record-disabled, the Record
indicator in the Status window will have red cross-
hatching in it.
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at 44.1 kHz
Clicking on the four-letter code of a Preset will reveal a popup menu with 4 options:

ErGp  Enabled Record, Good Playback

ErBp  Enabled Record, Best Playback

DrGp  Disabled Record, Good Playback

DrBp Disabled Record, Best Playback

Changing Presets via MIDI

Changing your current Preset via MIDI
(since it is primarily designed for

performance) will not give you the
option of storing any changes in your

Preset.  When editing, it is thus
advisable to switch Presets from the

user interface.

To change a Preset via MIDI, you must send LiSa a
Program Change message on the channel you have
selected as LiSa’s System Channel in the System
Settings Dialog (see p.16).  The program change
number +1 will be the Preset you call up (pgc 0 =
Preset 1, etc.).

Stop Notes on Preset Change Option: When this is checked (in
the Options menu), all currently active notes will be silenced, and all
Control values that you have changed while using the Preset will be
set back to their original values.  If it is not selected, all active Zones
will remain active until turned off, and returning to that Preset, you
will find all of the controllers in their last position before you changed
Presets.  If you are switching between Good and Best playback
quality, all notes will always be stopped.

SSSSeeeettttuuuuppppssss
A Setup is the actual file you save when you select Save in the File menu, and is the file you load or
open from the New Setup... or Open Setup...  File menu items.  It is comprised of:

� All the Presets you have written for that Setup.

� The preferences you have set in the Global menu.  Each
Setup can have its own System Settings, buffer sizes, and
pitch bend range.

� Audio hardware settings and input/output routings

� OMS Settings and routing.

� All selected Options in the Options menu, except for Show
Current Sample Pointer, which always reverts to on.

� Pointers to Libraries.  All data structures such as Zones and
Tables, which are stored in Libraries, are stored in separate
files, and the Setup remembers which Libraries to open up
with the Setup.
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LLLLiiiibbbbrrrraaaarrrriiiieeeessss
All data structures in LiSa are created and stored in
a Library.  Nine Libraries contain all of the data
structures used in LiSa: Zones, Patterns, Envelopes,
Tables, Controllers, Samples, MIDI Processors,
MIDI Snapshots, and Parameters.  These are
separate files from your Setup file -- any number of
Setups can share Libraries.  When you save your
setup for the first time, LiSa will create a folder called
‘Libraries’ in the same folder as your new Setup file.
All new libraries are saved into that file.  They are
automatically named with the name of your Setup
plus the type of Library.  (For example, if your Setup
is called Foo, upon saving it LiSa will create Library
files named ‘Foo Envelopes’, ‘Foo Controllers’, etc.)

Once created, Libraries may be saved in any location on your hard drive – they need not be in the
same folder as their original Setup.  LiSa will remember their access path as long as they remain on
the volume on which they were created.  All standard Macintosh edit functions work in Libraries –
Items in Libraries can be duplicated, cleared, etc. via the Edit menu.  Some Libraries exhibit slightly
differing behaviors, which are mentioned in their specific sections.  The explanations below apply to all
Libraries, whatever their type.  The one exception is the Parameter Library, which is not changeable,
and simply provides a list of the control parameters available.  For use of the Parameter Library, see
Parameters and Controllers on p. 86.

Library Functions

� Creating new data structures.  All Zones, Controllers, etc. are
created by using the New button in the library window of that
type.  Some of these structures may also be created in other
ways as well, but they can all be created from Libraries.

� Managing data so it can be used by multiple Setups.  As
mentioned above, multiple Setups may share Libraries.

� Reference for what structures have been created, and
whether they are used in a Setup.  (The exception to this is
the Parameter Library, which indicates the used Parameters
in each Voice Layer, not Setup.)

� Drag-and-drop of data into a Preset.  An item from any
Library can be dragged to an appropriate numerical or menu
item.  For example, any table may be dragged to a CTab
numerical in a Zone Editor Window, and samples in the
Sample Library may be dragged directly into the Sample
Buffer or the Sample Editor.

Loading Libraries

When loading a set of old
Libraries into a new Setup,

it is best to load the Zone
Library last.  If the Zones
have pointers to patterns
or envelopes in a Library

that isn’t loaded yet, those
pointers will be lost.

To load an existing Library into an open Setup,
select Load Library... from the File menu.  This will
bring up the standard Open File dialog box.  Once
you have selected a file to load, you will be
presented with a dialog box asking if you want to
replace the current Library, or append the Library
you are loading to it.  Selecting Append will add the
Tables, Envelopes, or whatever, to the end of the
current Library of that type.

Selecting Replace will delete whatever was in there previously.  When you select Append, the current
Library will keep its original name.  Selecting Replace loads in the new Library, name and all, into your
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Preset.  All of these operations can be performed while the Library windows are open or closed. If you
Load items into a closed Library you will see the results when you open it.

Saving Libraries

You can save a Library independent of the Setup
at any time by selecting Save Library from the
File menu.  This has a submenu where you can
select the library you wish to save.
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SSSSoooouuuunnnndddd    MMMMaaaannnnaaaaggggeeeemmmmeeeennnntttt

This chapter describes how to handle samples that are already on disk, in LiSa’s buffers, or samples
that you are recording while editing a Preset rather than performing.  For information about how to
record samples in performance, see the chapter Recording a Sample on p. 68.

New in v. 2.5:  All
Stereo!

LiSa is now 100% stereo.  This means it can
record, manipulate, and play interleaved
stereo soundfiles, in either sd2 or aiff format.
If you use a mono soundfile in LiSa, it will
appear as a stereo sample in the Status
Window and the Sample Editor, but the
sample itself will remain untouched.

TTTThhhheeee    SSSSaaaammmmpppplllleeee    LLLLiiiibbbbrrrraaaarrrryyyy
The Sample Library does not
actually contain any samples.
Rather, it is a list of pointers to a
set of the soundfiles on your hard
drive.  These samples do not
need to be in any particular
location on your drive, or even on
the same volume.  Once in a
Library, as long as the sample
remains on the same volume,
LiSa will be able to find it.
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AAAArrrrcccchhhhiiiitttteeeeccccttttuuuurrrreeee    ooooffff    tttthhhheeee    SSSSaaaammmmpppplllleeee    LLLLiiiibbbbrrrraaaarrrryyyy
A Sample Library can hold up to 2048 soundfiles, in AIFF or Sound Designer II format.  In addition,
.wav files can be converted by LiSa, see Building a Sample Library, p. 36 A library is divided into
four Batches of 512 samples each, named A through D.  A particular sample is not permanently
assigned to a particular Batch – it will depend on the number of samples in the Library, and whether
the samples are being sorted by name or size.  For example, if you have 1000 samples in your
Library, and they are sorted by size, the shortest 512 will be in batch A, and the remainder in batch
B.  If sorted by name, the ones closer to the beginning of the alphabet will be in Batch A, and the
later ones in Batch B.  You can switch between batches by using the lettered menu to the right of
the Sample Name pane.

Building a Sample Library
There are five ways to add samples to a Sample Library:

Click on the Add button.  It will bring up a dialog
from which you can add soundfiles to the
Library.  You can select multiple items in the
open dialog by shift-clicking.

Click on the Scan button.  If you have multiple
drives on your system, it will present a popup
menu from which you can choose a drive.
Once the drive is selected, LiSa will scan the
drive for all readable soundfiles and add them
to the Library.  The number of samples found
can be seen in the System Messages pane of
the Status window.  Aliases on a drive will be
resolved.

Click on the Import button to convert CD tracks or
.wav files. If you add a .wav file or a CD track,
it will be automatically converted to AIFF. You
will be prompted to name the converted
soundfile and choose a location to save it to.
All imported files will be saved as 44.1 kHz,
stereo AIFF.   If QuickTime is not available,
this item will be dimmed.

Drag selections from the Sample Editor over to the
Sample Library, which will automatically save
them to disk.  You will be prompted to name
the new soundfile and choose a location to
save it to.

Drag AIFF or SDII files from the finder directly to the
sample library.  If they are valid soundfiles,
LiSa will add them.  The Add button will be
highlighted as you drag to indicate that it s
valid file.
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Working with the Sample Library

The Sample Library has seen extensive renovations in version 2.5.  All sample file
actions are now handled in the Sample Library window. The Load Sample and Import
menu items have been removed, and are now replaced by functions available directly
in the sample window. In addition, the Sample Library has many closely integrated
features with the Sample Editor, (p. 40), the Zone Editor, (p. 23), and the Preset
Window (p. 29).

Display

The Sample Pane shows the filenames of the samples in the Library, and its length in
seconds.  Once there are samples in the Library, the list can be sorted either
alphabetically or by length, depending which option is selected in the lower left
corner.  A sample used in a Preset, either in the currently active Zone Library, or as a
Preset Sample Load, will have a bullet next to its name.  The ‘∞’ character to the left
of the sample name indicates stereo soundfiles.

Navigating the Sample Pane

You can now navigate around in the Library by typing the initial letter of a sample you are looking
for, but please note that this feature only works within the currently visible Batch.  In addition, the
up/down arrow keys will move your selection in the indicated direction.

Multiple soundfiles can be selected in the Library and removed from it (but not from your hard drive)
using the delete key or by selecting the Clear item in the edit menu.  Please note that if you use the
Select All menu item to clear samples, you will only be clearing the currently visible samples in the
pane.

Other commands are:

Rename.  Clicking on this will bring up a dialog in
which you can rename the sample.  This is
identical to changing the name in the Finder.

Location.  Clicking on this button will present a box
showing the filepath of the selected sample.
The box will remain visible only as long as the
mouse button is held down.

Trash.  Puts the selected soundfile in the Trash.  It is
not an immediate delete – the Trash must be
emptied for the soundfile to be permanently
thrown out.

Play.  Activating this button will play the selected
soundfile.  Clicking it again will stop playing.
Double-clicking on any sample name, or
pressing the spacebar when the Sample
Library is the topmost window will also play
the sample.
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Sort.  Soundfiles can be sorted by name or size.
Clicking on the appropriate button will reorder
the files in your Library.

Clear.   (From Edit menu).  Selected samples will be
cleared from the Library, but remain
untouched on your hard drive.  The Sample
Library must be the topmost window for this
command to work.  Please note that the
Select All option will only select samples
currently visible in the Library window.
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The Sample Buffer

To zoom your view of the sample Buffer
in the Status window, highlight part of

the zoom pane directly above the
Sample Buffer window.  The part

appearing in red is the section of the
buffer represented in the Sample Buffer

Window.

The Sample Buffer is the section of RAM allotted to
LiSa in which playable sounds actually live.  (For the
basics of this, see Sound in the Computer, page 9).
When editing a Setup, there are two access points
into the Sample Buffer: the Sample Buffer pane of the
Status window, and the Sample Editor.   Most of the
drag-and-drop functionality of the Sample Editor is
duplicated in the Sample Buffer pane, but actual
editing and processing of samples must be done in
the Sample Editor.  In general, it is best to do most of
your sample organization there.

Loading Samples into the Sample Buffer
There are several ways of loading samples into the Sample Buffer.  All of these methods are pastes,
not inserts, and will overwrite any previously loaded samples in the chosen location:

Cmd-L.  When the Sample Library is the active window, typing this will load the
highlighted soundfile in the Sample Pane into the beginning of the Sample
Buffer.

Dragging a sample name from the Sample Library to other windows will also load samples into the
buffer, in several different ways:

To a Playback Zone in the Zone Editor: As much of the sample as will fit into the
Zone’s region will be loaded, wherever it is in the buffer.

To the virtual keyboard: The sample will be loaded into the buffer immediately to
the right of the rightmost loaded sample, or at the beginning of the buffer if
empty.  In addition, a new Playback Zone, with the same name as the
sample, will automatically be created.

When dragged to either the Sample Buffer pane of the Status window, or into the Sample Editor,
modifier keys control the exact way you can locate the sample:

With no modifiers, the sample will automatically start from the beginning of the
buffer.

Option-drag will automatically place the sample after the last sample in the buffer.

Ctl+Option-drag allows you to place the sample in a specific location in the buffer.
Once you drag the sample over the Sample Buffer pane, a number box will
appear which will show you the exact location of the sample in the buffer.
In the Sample Editor, the exact location of the sample start point is shown in
the Loc Numericals located at the top of the window.
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When dragging samples to the buffer, a message will
appear in the System Messages pane of the Status
window to remind you of your current dragging mode.

Saving samples from the Sample Buffer
There are two ways of saving all or part of the Sample Buffer to your hard disk as a new sample.
Both of these methods will automatically add the new sample to the Sample Library:

Select the Save Sample Data... item from the File menu.  This will give you the
option of saving either the entire Sample Buffer or only the current visible
zoom as a SDII file.  Current visible Zoom refers to the visible area of the
Sample Editor window.    The new file is saved and automatically added to
the Sample Library.

 Highlight the region you want to save in the Sample Editor window.  A grabbing
hand icon will appear when the cursor is over the highlighted area.  You can
then drag it to the Sample Library, where you will get a standard Save File
dialog box.  Dragging it to the Preset window will also save the sample,
which will be loaded together with the Preset.

TTTThhhheeee    SSSSaaaammmmpppplllleeee    EEEEddddiiiittttoooorrrr
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New in v. 2.5: Major
changes in Sample

Editor functions

When working with prerecorded samples, and
designing arrangements of sounds for your Presets,
you will mostly be working in the Sample Editor
window.   Many functions in this window have been
changed since earlier versions.  The Cut, Copy, and
Paste buttons are gone, and now should be done via
the Edit menu.  The new buttons have no written
descriptions permanently in the window, but if you roll
your mouse over them, the name of their function will
appear in the Sample Editor window at the top of the
button column.

When working with prerecorded samples, and designing arrangements of sounds for your Presets,
you will mostly be working in the Sample Editor window.   Many functions in this window have been
changed since earlier versions.  The Cut, Copy, and Paste buttons are gone, and now should be
done via the Edit menu.  The new buttons have no written descriptions permanently in the window,
but if you roll your mouse over them, the name of their function will appear in the Sample Editor
window at the top of the button column.

Overview
The Sample Editor window shows the sounds in the Sample Buffer.  Changes made in one window
are immediately reflected in the other.  As the editor is only reflecting what is in RAM, any edits
made in the Sample Editor have no effect on any soundfiles on disk.  The entire buffer, or any part
of it, may be added to the Sample Library and saved to disk.  Unlike LiSa’s other windows, it can be
resized.

Appearance
Now that LiSa is fully enabled for stereo, the Sample Editor shows two channels for all sounds in the
editor, regardless of whether the file is originally mono or stereo.  The topmost channel is left.  The
waveform in the Edit window will also appear in as many as three colors:

� Black, for unselected areas.

� The sample region of the current Zone will appear in that Zone’s color.  This will also be
visible in the Status window.  This will only be the case when the Show Zone Color in
Sample Editor is selected in the Options menu.

� The selected area will appear in your computer’s ‘highlight’ color.

The time grid at the bottom of the Edit pane will be displayed in either seconds or thousands of
samples, depending on whether Show Length in Seconds or Show Length in kSamples is
selected in the Options menu

Navigation
The Sample Editor provides two views of the buffer: The Edit pane, and a smaller overview below.
The Edit pane can be zoomed in and out from the overview, which always shows the entire contents
of the Sample Buffer.  The part of the buffer visible in the Edit window is always shown in the
Overview pane in red.  In addition, the top row of numbers, labeled Current Zoom, will show the
exact start point, end point, and duration of the area visible in the Edit window.  The view in the edit
window can be changed in the following ways:

To change the Zoom, click on the magnifying glass icon, and drag the mouse
vertically.  The cursor will change to a magnifying glass.  Moving up
increases the magnification, and down decreases it.  Holding down the Shift



LiSa v. 2.5 manual, p. 42

key and click-dragging the cursor up and down inside the overview pane
has the same effect.

To move back and forth in the buffer, drag the red area of the overview pane
back and forth. Clicking in the overview will immediately move the area
visible in the Edit window to that location.

There are also two types of buttons to aid changing views:

Zoom Selection.  Clicking on this button will zoom in
the Edit pane on the selected area.

Snapshots.  The four numbered buttons on the
Sample Editor, called Snapshot buttons,
serve as view memories.  Shift-Clicking on
one of these buttons will remember the
location and zoom view of that portion of the
Sample Buffer, and a normal click will return
the Edit window to that view.  When a
Snapshot has been loaded, the number in the
icon changes from green to red.  Snapshot 1
automatically defaults to a view of the entire
Sample Buffer.  Snapshots are saved with
your Setup.

Playback

To start or stop playing in the Sample Buffer, press the spacebar.  You will hear the sound beginning at
the current cursor location.  If you have selected part of the buffer, the highlighted area will
automatically be looped.  If nothing is selected, the area currently visible in the Edit window will be
looped. (The selected area will take priority over visibility, so if a selected area is partially or entirely

For playback and
editing functions to

work, the Sample
Editor must be the
topmost window.

invisible, you will still hear it.) Hitting Return or Enter
will move the cursor to the beginning of the window. It
is also possible to start playback using the playback
button in the Sample Editor Window.

Editing

Selecting

To select a portion of the buffer, click-drag with the mouse.  Shift-clicking will extend the selection.
The highlighted area can also be fine-tuned with the Arrow keys:

 Option-left arrow and Option-right arrow will nudge the left-hand edge of the
selected area.

 Option-up arrow and Option-down arrow  will nudge the right-hand edge to the
right and left, respectively.

Selecting and the hand grabber: If you have
selected part of the Sample Buffer in the

Sample Editor, when you pass the cursor
over that area, it will turn into the hand

grabber tool.  To get back to the normal
cursor (to click in the selection area), hold

down the Option key.

The nudge size is 1 kB of samples (1024
samples, or about .023 of a second).  Once a
selection is made, its exact start point, end
point, and duration will be displayed at the tip of
the window, in the row labeled Selection.  You
can only select both channels at once – it is not
possible to perform any operations on only one
channel of the buffer.
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Edit functions

The standard Macintosh edit functions operate when the Sample Editor is the frontmost
window:

Cut will remove the selection and put it on the clipboard. Any samples in the buffer
to the right of the selection will be shifted to the left (earlier) in the buffer.

Copy copies the selection to the clipboard, leaving the original untouched.

Paste will insert the sound on the clipboard at the insertion point, moving all sounds
to the right.  If paste is used when a region of the Sample Buffer is selected,
it will replace whatever is in that region.

Clear (Available in the Edit menu or the Delete key) will do the same as Cut, but
not to the Clipboard.

Undo will undo the last action you performed in the Sample Editor.

Special Functions

In addition to the view changes, the Sample Editor has several processing functions to make
changes to the sounds in the Sample Buffer.  Some are available from the Sample Editor window,
and others from the Edit menu.

In The Sample Editor window

Normalize Selection/Normalize Level.  This
normalizes the selected area of the
Sample Buffer.  This affects only the
buffer, and samples on disk are left
untouched.  This is also available in the
Edit menu, or by pressing Cmd-M.  This
is a non-real time option, so it’s not
recommended for live use. Directly below
this button is a numerical you can use to
set the normalization level of the
selection, from 10 to 100% (the default)
of the full amplitude range.  Thus it can
be used to decrease as well as increase
gain.

Limit Selection. This Button will reduce the
amplitude of any part of the selected area
of the Sample Buffer that is above a
certain threshold. Samples or parts of
samples with an amplitude below the
threshold are untouched. The threshold is
expressed as a percentage of maximum
volume, and is set in the numerical
directly below the button.
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Gain Selection.  This button will increase or
decrease the gain by the percentage
specified in the Amplify Current Zone
setting in the LiSa Settings dialog.  (This
dialog is found in the Global menu. See
P. 15 for more on the LiSa Settings
window.) This works much like the MIDI
controlled Amplify Current Zone option (p.
96), but it works for the highlighted area
of the buffer rather than the current Zone.

Save Sample to Disk.  You can drag any
selected area of the Sample Editor to
either the Sample Library or the Preset
Window.  A save file dialog will come up,
and you can choose where to save the
new soundfile.  If dragged to a Preset,
that sample will be automatically loaded
when that Preset is called up.

In the Edit menu

Clear Sample Buffer.  This menu item will clear the entire buffer of all samples.

Enter Selection in Zone.  This item, available in the Edit menu, will automatically
set the Start and Length parameters of the Zone currently in the Zone
Editor to that of the current Selection.  You can do the same thing by
selecting a portion of the Sample Buffer and dragging it to a Zone.

Enter Current Region in Zone.  If you change the size of the current Zone via
MIDI, selecting this from the Edit menu will automatically resize the sample
region of the Zone to the current one.

Normalize Selection.  This menu item normalizes the selected area, but unlike
the button of the same name in the Sample Editor window, it is always
100% normalization.

Reverse Selection.  Works just like it sounds.  Samples in the selected area are
reversed.

RRRReeeeccccoooorrrrddddiiiinnnngggg
It is now possible to record directly from an external sound source to the Sample Buffer in the
Sample Edit window.  The window now has level input monitors on the right, so you can see your
input levels.

For those of you with ASIO cards supporting multiple inputs, keep in mind that the
Sample editor will only monitor or record audio input from channel A.

Selecting your record region

Recording will always begin from the current playback cursor location.  It will continue until the end
of the visible zoom is reached, or the end of the buffer. Recording in this mode does not loop.  When
it reaches the end of the visible zoom or the sample buffer, recording will stop automatically.

To only record into a certain portion of the visible zoom, highlight it, and initiate record.  Recording
will stop once the cursor reaches the end of the selected region of the Sample Buffer.
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Initiating recording

Once you have decided what portion of the sample buffer to record into, you can start recording in
two ways:

Click on the record button in the top-left of the Sample Editor.  A green square will
appear in the center of the record button to indicate that recording is taking
place.  Clicking the record button again, or pressing the spacebar, will stop
recording.

Press Cmd-space on your computer keyboard, when the Sample Editor is the
frontmost window.   Pressing the spacebar or clicking the record button will
stop recording.

Once you have recorded your sample, and modified it to your taste, you can save it by selecting the
area you wish to save and dragging it to the Sample Library.  If you drag it to a key on the keyboard,
a new Playback Zone with the same start and end points as your selection will be created, but it will
not save your new sample to disk.
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TTTTaaaabbbblllleeeessss    aaaannnndddd    EEEEnnnnvvvveeeellllooooppppeeeessss

There are two data structures in LiSa which serve multiple functions in different contexts: Tables
(often referred to in LiSa as ‘CTabs’) and Envelopes.  This chapter contains basic information on
both of these structures, and will briefly mention their applications in different aspects of LiSa.  Their
use in particular contexts are explained in full in the relevant chapters.

TTTTaaaabbbblllleeeessss
Tables are one of LiSa’s most powerful features, and it is hard to overstate their importance in any
advanced LiSa setup. This chapter deals with tables in general; it is best to look in the specific
sections below and in the example Setups to see their more advanced uses.  Some of the main
applications of tables are:

� To modify parameter controls. (p. 93).  Any MIDI controller input can be remapped.  A linear
control input from 0 to 127 can be mapped to 127-0, a set of random numbers, index values
for other parameters such as envelope or pattern select, or any other set of values in the
MIDI range you may need.

� As drivers for modulators (p. 84).  Any modulator can be driven by a custom table as large
as 512 steps, making it possible to create any pattern you desire.  It is also possible to
switch between tables in a modulator, giving you unlimited flexibility.

�  Tables can be used to generate sound using wavetable synthesis (p. 58).  You can even
cut and paste (very) short sections of soundfiles as sound generators.

� Tables can themselves be changed in real time via MIDI (p. 94), bringing an additional level
of flexibility.

Creating a new Table
Like all other data, tables are stored in a Library.  The Table Library window works identically to all
other Libraries.  There are two ways to create a new table:

� Click on New in the Table Library
window.

� Select the New Table menu item
from any of the popup menus labeled
CTab in the Zone Editor, the MIDI
Process Editor or the Controller Editor.

This will immediately open the Table Editor
window, with a new table full of random
values.  A single Library can hold up to 256
tables.  Each new table’s name will appear in
both the Table Library and the CTab popup
menus in the Zone Editor.



LiSa v. 2.5 manual, p. 47

The Table Editor

The top row of the Table Editor has the usual LiSa identification number (you can change the table
you are editing by scrolling through this numerical or using the right and left arrow keys when this
window is topmost) and name field.  There is also a third numerical to control the table’s size
(domain).  Default (and maximum) is 512.  Note that the Y values are stored in the table as 32-bit
floating-point numbers.  When tables are used as indexes, they are truncated to integers.

The Table Editor window can be viewed in two ways: graphically (the default) and numerically.  You
can toggle between these two views by clicking on the radio buttons marked with a pencil or the icon
with the numeral 2 on the right-hand side of the window.  These two views reflect the same
information, but each view has slightly different editing capacities.  Tables can be drawn, edited
number-by-number, generated using the Function buttons, or copied directly from the Sample
Editor.

Graphics view

In this view, shown above, one can simply draw the desired curve into the Editor window.  The X
and Y values of the cursor are shown in the location box at the bottom center of the editor.
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Numerical View

In this view, the table is represented as one or
more pages of 128 numericals.  Each
numerical shows the Y value for an X value
that corresponds to its position in the table,
ranging from zero to the domain of the table.
Putting the cursor over a numerical will show
its X and Y values in the location box at the
bottom center of the table. You can only see
128 values at a time in this view – to go to
higher or lower ranges, click on the boxes with
the triangles on the lower left and right of the
Editor window.  In numerical view, the
numbers are color-coded, to help you see the
general movement of the curves:

� If a number is higher than the previous
number in the table, it appears red.

� If a number is lower than the previous
number in the table, it appears green.

� If a number is the same as the
previous number in the table, it appears
black.  The first value in a table is always
black.

To edit in numerical view, scroll the numerical corresponding to the X value you want to change to
its desired value, or type in the value.  In numerical view, you can type in a full 32-bit floating-point
number, but only the first two numerals to the right of the decimal point will be displayed. (It is handy
to have your highlighting color set to something other than black -- it makes it much easier to see
what is happening in the tables.)

Function Buttons

The Table Editor has two types of function buttons.  Some put in a standard set of values, and some
allow you to set certain parameters and apply a function to them.

Set functions

These buttons will always exhibit the same behavior, adjusting to the size of the table.  Minimum
and maximum values cannot be scaled, and are always from 0 to 127.  When the mouse is over
these buttons, the name of their function will appear at the top of the window.

Linear.  This button creates a linear table, with Y
values beginning at 0, and reaching 127
at the maximum X value of the table.

Reverse Linear.  This loads the exact inverse of
the above table, with the lowest value of
X being equal to 127, and the highest 0.
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Triangle.  Maps a triangle wave beginning and
ending with zero to the full domain of the
table.

Variable functions

You can create several line segments or random ranges using the Variable Function buttons.
These now work in both Numerical and Graphic views.

New in v.2.5: You can use
the Line Segment and
Random functions in

Graphics mode.

Line Segment.  Creates any number of
breakpoint line segments. In Numerical
view, Shift-click on a numerical in the
Table Editor will select it.  When you set
the selected numericals to values of your
choice and click on this button, LiSa will
automatically interpolate a line segment
between pairs of the selected numericals.
If no numericals are selected, and you
click on Line Segment, it wil l
automatically interpolate a line from the
first to the last value in the visible page of
the table.  To create a table with more
breakpoint line segments, you have to
have at least two numericals selected.

Random.  This function works very similarly to
the Line Segment function.  Clicking on
this button with no numericals selected
will create a flat random distribution in the
range 0-127.  By selecting pairs of
numericals the same way as line
segments, and clicking on this button,
you can create a random distribution
within the limits set by the selected
numericals.  When creating these
‘segments’ of limited random distribution,
the numericals that start and end the
region may change when you click the
button, as they are included as part of the
random distribution.  As with line
segments, you can create as many
regions of different distributions within
one table as you wish.

In Graphics view, the system is similar. Shift-clicking on a point or set of points in Graphics view is
identical to shift-clicking on a set of values in the Numerical view.  Clicking on the Line Segment or
Random button will behave exactly the same way as well.    When you shift-click on a point, a red
dot appears at the bottom of the table indicating the position on the x axis you have shift-clicked.

All selected points on a table can be cleared by
clicking on the Clear Selection button beneath the
Numerical View button.  Note that this will clear
selected points in both graphics and Numerical
view.
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Copying from the Sample Editor

You can copy data directly from the Sample Editor and paste it into a table.  (Only the first 512
samples of your selection will be used.)  Particularly useful when using a table as a Wavetable (see
Wavetable Zones on p. 58), this technique will work if the table is in either graphic or numerical
view.  To do this, select any highlighted area from the Sample Editor, and drag the selection directly
into the Table Editor.
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EEEEnnnnvvvveeeellllooooppppeeeessss
Only general handling of envelopes is covered here.  Specific applications of envelopes are covered
in their respective sections:

� For Amplitude control, see Amplitude Envelopes on p. 61.

� For Filter control, see Filters on p. 62.

� For Wavetable mixing, see Wavetable Zones on p. 58.

Envelopes in Setups
Envelopes are stored in and accessed from an Envelope Library.  You can change the amplitude
envelope of a Zone by sending it MIDI, using the Envelope Select parameter (p. 90). Default is to
envelope No. 1.

Creating and editing envelopes

To make a new envelope, you can either:

Click on the New  button in the Envelope
Library window (available in the
Windows menu, or by typing Cmd-4.).

Click on the V a l numerical next to the Env
parameter in the Zone Editor.  A popup
menu of all available Envelopes will
appear, together with options for
creating a new Envelope or editing the
current one.

They are edited in the Envelope Editor, which is also available in the Windows menu, or by
double-clicking on an envelope in the Envelope Library.  You can cycle through
available Envelopes in the Envelopes editor by using the left and right arrow keys.
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Envelopes in LiSa are basic ADSR envelopes.  They contain 4 stages; each scaled from 0 to 99,
except Sustain, which is scaled from 0-100.  Lower values mean shorter time durations.

Attack.  The time it takes the envelope to reach its maximum value.

Decay.  The time it takes to go from full value to the sustain level.

Sustain.  The value of the envelope after it has passed the decay stage.  It will
remain at this value as long as the Zone is active.  Note that this is not a
duration.

Release.  The time it takes after the Zone is deactivated (your finger is off the key)
for the envelope to return to zero from the Sustain value.

Envelope timing
Timing on LiSa’s envelopes have been improved in version 2.5, resulting in less latency, and a
wider range of control over timings.  The minimum possible attack is now approximately 1.5 ms, and
the maximum is very long.  The maximum speed of envelopes is directly related to the Sample
V e c t o r  s i z e  o f  y o u r  S e t u p ,  s e e  A p p e n d i x  A  f o r  d e t a i l s .
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PPPPllllaaaayyyyiiiinnnngggg    BBBBaaaacccckkkk    aaaa    SSSSaaaammmmpppplllleeee

Once you have sound in the buffer, there are a great variety of playback methods for sampled
sounds.  All of these are done with Playback Zones.  The exact way in which the playback works is
determined by the mode of the Zone.  In this section we will look at these possibilities in detail.

DDDDeeeeffffiiiinnnniiiinnnngggg    aaaa    ZZZZoooonnnneeee
The process for defining a Playback Zone, like all Zones, is comprised of 5 parts:

� Creating a new Zone in the Zone Library window.

� Assigning a sample region to the Zone, in the Zone Editor or
the Sample Editor.

� Assigning the Zone to an activation key or keyrange in the
Assignment window.

� Selecting output routing, if you are using a soundcard with
more than two outputs.

� Defining the Zone’s functions in the Zone Editor.

� Creating Parameter Control variables for the Zone, if desired.
This happens in both the Zone Editor and the Assignment
window, and will be discussed in full in the chapter
Parameter Control  on p. 84

The order you do these in is of no particular importance (though it helps to create the Zone first), and
you can freely readjust any parameter at any time.

CCCCrrrreeeeaaaattttiiiinnnngggg    tttthhhheeee    ZZZZoooonnnneeee
The first step is to create a Playback Zone and assign it to a keyrange on the virtual keyboard in the
Assignment window.  Click on New in the Zone Library window, and a new Zone will appear.  Assign
it to a keyrange by clicking on the Zone name and dragging it to the virtual keyboard.  When defining
the range for your playback Zone, remember that it is in Playback Zones (and in Playback Zones
only) that the location of the Zone on the keyboard is related to the pitch of the sound you hear.
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DDDDeeeeffffiiiinnnniiiinnnngggg    tttthhhheeee    SSSSaaaammmmpppplllleeee    RRRReeeeggggiiiioooonnnn
The numericals in the Region pane of the Zone
Editor define the sample region of the Zone (the part
of the sample buffer it acts on) and set the Zone’s
playback pitch.  Please note that all of these
parameters can be controlled via MIDI, and are
amongst those most often used in LiSa.

When setting these
two parameters, Len

takes precedence over
Stt.  That is to say in a

10-second buffer, if
Len is set to 3

seconds, Stt will
automatically not go

past 7 seconds

Stt  (absolute region start).  Sets the absolute start
time of the Zone’s region – the segment of
the Sample Buffer from which the Zone will
access sample data.  This numerical will
always have a minimum of 0.  The maximum
depends on the amount of memory you
have allotted to the Sample Buffer.  This is
an absolute offset -- MIDI controls can only
make the region go above (to the right in the
buffer) this position, not below.

Len   (length).  Sets the length of the Zone’s sample
region.  Minimum is 1 kB of samples (±
0.023 seconds) and maximum is from the
start time to the end of the buffer.  Default is
5.00 seconds.

Mvr  (movement range).  This numerical is used to
define the effects of MIDI data sent to the
above parameters.  When this value is set to
0, MIDI sent to the Stt parameter will have
no effect.  Set to maximum (again,
automatically the length of the buffer), the
full range of a MIDI controller (0-127) will
cover the full range of the buffer.  If set to
half the length of the buffer, it will cover half
the length.  Default is the entire length of the
buffer.

You will notice that we are ignoring the CTab popup menus.  These are related to how their variables
interpret MIDI information, and will be discussed at length in Mapping MIDI Controllers – CTabs on p.
93.

Quick Zone Creation

In many cases, you will want a Playback Zone to simply correspond to one sample in the buffer.
There is a fast system for creating such Zones, combining keyboard assignment, buffer region, and
transposition in one simple gesture.

Drag a sample from the Sample Library directly to the Virtual Keyboard in the Assignment Window,
and assign a keyrange.  This will automatically:

� Create a new Playback Zone, with the same name as the
sample.

� Load the soundfile into the Sample Buffer, immediately after
the last sample in the buffer.

� Set the sample region to the exact size and location of the
sample.

� Set the Tun parameter of the zone so that the leftmost key in
the keyrange selected will play back the original pitch of the
sample.  This holds true regardless of how the tuning of your
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keyboard is set.

It is possible, by dragging samples larger than your buffer, to actually create Zones larger than your
buffer size.  This can cause problems, and after saving and restarting such a Setup, you may receive
a warning dialog when loading.  You should check out your Zone sizes or resize your buffer before
proceeding.

PPPPiiiittttcccchhhh
Pitch transposition of sampled sounds is one of the most common uses of samplers.  LiSa gives you
full control over your playback pitch, including the ability to implement non-equal tempered scales.
The pitch of a Playback Zone can be altered in two ways:

� By changing the Tun value in the Region pane of the Zone Editor.

� By playing it back on different MIDI notes in its keyrange.

Initial Pitch

When tuning a sample
from this numerical, you

will only hear the new
pitch when you trigger

the sample again.  (This
is not true, by the way,
when you alter Tun via

MIDI.

To change the note number that will play the sample
back at initial pitch, you adjust the Tun numerical in
the Region pane of the Zone Editor.  When you
record a sample, LiSa will default to playing it back
at its initial pitch at note 60(c3)  (We call this the
initial pitch of a note, regardless of what its pitch is in
the real world, or even if it has no pitch at all).  Thus,
in a Playback Zone that begins at note 72(c4), the
lowest it will be able to play a sample will be one
octave above the sample’s initial pitch.

This numerical has a range of -60 to 60, measured in half-steps, which allows you to adjust the initial
pitch of the Zone over a 10-octave range, centered on note 60 (c3).  This is a dual numerical: by
pressing the shift key, you can fine-tune the initial by plus or minus 99 cents (1/100 of a half-step).  If
the tuning in cents is anything other than zero, the coarse-tuning value will appear in bold.

Keyboard transposing

The playback pitch of the Zone will be relative to the initial pitch you have set in Tun.  A Zone with a
Tun value of -12 will play back a sample on key 60(c3) at a pitch one octave lower than its original
pitch -- the effective playback pitch will be 48(c2).  With a combination of Tun and your keyrange, you
can play back the sample in any transposition or possible sets of transpositions you desire.

Scale Retuning

Default tuning for the virtual keyboard is 12-tone equal tempered.  It is possible that you may want to
use a different scale.  You may want to implement just or microtonal tunings, or have the keyboard
tuned in some completely nonscalar way.  This can be easily implemented in LiSa.  Look at the
Assignment window and press the Tab key.  The virtual keyboard will change into this:

The keyboard will not
switch back into normal

This is a representation of one octave of the virtual
keyboard (notes 60-71, c3-b4).  The note numbers
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mode (keyrange setting
mode) if the cursor is in

one of the tuning
numericals.

are shown on the lowest row.  As with the normal
keyboard, you can view above or below this octave
by clicking on the arrow buttons to the right and left.
Above the note numbers are a set of numericals
representing the pitch value of each note, expressed
in cents.

Each of these numericals has a range of 0-12000, thus making it possible for each MIDI note to play
at any pitch within LiSa’s entire range.  The virtual keyboard for each Voice Layer can be tuned
separately.  These pitch tables are stored at the Preset level, meaning that each Preset can hold 16
pitch tables, one for each Voice Layer.

Preset Tunings

There are a few keyboard shortcuts for the most common tunings.  Hitting these keys at any time will
tune the virtual keyboard for the currently selected MIDI channel.  These are not Cmd-key
combinations.  A dialog will appear asking for confirmation that you in fact want to retune the
keyboard.  The available shortcuts are:

� N = normal; 12-tone equal tempered.

� K = quarter-tone equal tempered scale; two MIDI notes to the half-step.

� U = unison; all notes play back at note 60(c3).

OOOOuuuuttttppppuuuutttt    RRRRoooouuuuttttiiiinnnngggg
If you are using a soundcard with multiple
outputs in your computer, and have installed the
appropriate ASIO drivers, this popup menu will
be visible.  Here is where you choose which
lettered stereo pair the Zone will send its output
to.  Keep in mind that it is the Playback Zone that
determines output location, not the sound in the
buffer.  It is possible to make several Zones that
play the same sound, but with different output
routings. For configuring output, see p. 14.

TTTThhhheeee    PPPPllllaaaayyyy    TTTTrrrreeeeaaaattttmmmmeeeennnntttt    PPPPaaaannnneeee
The variables appearing in this pane control the
basics of playback.  All of these parameters are
MIDI-controllable.

Lev (level).  This numerical controls the overall level of the Zone’s
output.  This parameter is always linked to the velocity of the
played note, so that a velocity of 127 will output the value
shown in this numerical.  (For more on this, see Velocity
Mapping, p. 95.)  Maximum is 100 (100% of the original level
of the sample), and minimum is 0.  Default is 100.

Pan (panning).  This controls the location of the sounds in a stereo
field.  The range is from -100 (hard left) to 100 (hard right).  0
is center.  The exact behavior of Pan when used with live
MIDI is dependent on the type of controller used.  For more
information, see Channel and Voice MIDI Control, p. 87.

Env (envelope). A popup menu which selects between available
amplitude envelopes.  It is possible to change the envelope
via MIDI control – see the Output Parameters section of the
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Parameter menu, p. 90.

In addition, in the lower-right corner of this pane are the special parameters, unique to each mode,
and will be described below with the playback modes.

DDDDeeeeffffiiiinnnniiiinnnngggg    tttthhhheeee    ZZZZoooonnnneeee’’’’ssss    FFFFuuuunnnnccccttttiiiioooonnnn
The Zone you have just created should be visible in
the Zone Editor window.  The Zone’s function is
defined from Function icon, the leftmost one in the
Editor window.  (For more, see Zone Functions, p.
27.)

The default function for new Zones is Playback, so you are ready to start setting its modes.  Different
modes will also change the parameters available in the Play Treatment pane, so we’ll be jumping
back and forth a bit between the two.  The function of  the bottom right numerical in the Play
Treatment pane changes the most depending on the playback mode. This numerical is called the
special parameter numerical, and all references to special parameters below refer to this numerical.

Defining the Zone’s Modes

The Playback Mode menu, the leftmost of the
Function buttons, determines the basic ways the
Zone reads the information in its sample region.  It
covers things like the direction (or directions) the
Sample Buffer is read, and also includes some
secondary processing (effects) options.
Generally, listening to them will make their
function more clear to you than the descriptions
below, so we encourage you to experiment with
the program as you read.

Forward (default).  This simply plays the sample region from
beginning to end, with no secondary processing.

Backward.  As above, but playing from the end of the region
towards the beginning.

Back and Forth.  In this mode, the Zone’s region is read first
forwards and then backwards upon reaching the end.  A
Zone in this mode and in Once or Trigger mode (see below)
will play the region once forwards and once backwards
before coming to a stop.

The Fuz Parameter.  In the Play Treatment pane, these three modes all have the special parameter
Fuz, which is a distortion algorithm.  When set to 0, there is no distortion.  As the value of this
parameter increases, so does the distortion.  The louder the initial sample, the faster distortion will
occur.  This, like all distortions in the Sample Buffer, is an analog-type distortion, and will not create
nasty digital clipping.

In v. 2.5, the
autopan mode

has been

Spiral Algorithm.  The exact operation of this algorithm is a trade
secret -- you just have to listen to it and see what it sounds
like.  Its special parameter is called Spiralness, or Spl in the
Play Treatment pane.  It’s a non-linear parameter -- you just
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removed. have to try it out!  The range varies, depending on the
sample vector size.  Default is 64.

Pattern Mode Rough.

Pattern Mode Smooth.  The Pattern modes are one of LiSa’s most
powerful playback options, and are complex enough to merit
a chapter of their own.  To learn more, see Pattern Modes,
p. 64.

The Scrub mode
will only work

well in
conjunction with

the Looping
mode (see the
Activate Mode

menu below)

Scrub.  This is LiSa’s attempt at commercial success with the
hiphop crowd.  It uses the Scb parameter.  With an initial
value of 64, you will hear no sound.  This is because the
sample is not ‘moving.’  As you increase the values above
64, you will hear the sample looping in a forward direction,
starting very low, and increasing in pitch as the control value
goes up.  As you go below 64, the same thing will happen,
except the sample will go backwards.  At a value of 72
(forwards and default) or 56 (backwards) the sample plays at
its original pitch.  It responds to MIDI values exactly the
same way.  The total pitch range covered is from as slow as
possible to 4 octaves above unbent pitch.  This is most
useful when connected to the Pitchbend parameter of your
keyboard -- it’s already centered at a control value of 64.

Resonator.  The Resonator uses a combination of delay and
feedback to emphasize the upper harmonics of a sound.  By
adding the sample to itself with a slight delay, resonances
are created.  Playing with it is also the best way to get the
hang of what happens when you change the special
parameters.  This mode has two special parameters, which
may be accessed by holding down the shift key.

� Res (resonance frequency).  This controls
the emphasized frequencies.  Range is from
0-127, default is 64.

� Dpt (resonance depth).  This controls the
amount of the sample that is fed back.  The
resonance value can be either positive or
negative, but as it is mapped to MIDI, 64 is
equal to 0.  At 64, no resonance will occur.
As you increase the resonance depth in
either direction, you will increase the
strength of the upper harmonics, but with
different timbral results depending on
whether your value is above or below 64.
Range is 0-127, default is 64.

Wavetable Zones

Although this mode appears with the playback modes, it differs from them in that it does not read
samples from the Sample Buffer.  Instead, it reads from tables.  (For a general discussion of tables,
see Tables on p. 46).  Wavetable Synthesis is a technique that uses a set of numbers stored in a
table as if it were one cycle of a repeating waveform, turning the table into a lookup oscillator.  By
reading the tables at different rates, one changes the pitch of the oscillator.  The exact timbre of the
sound produced will depend on the shape of the wave inside the table.  Wavetable Zones in LiSa use
two tables, which can be modulated together.  The only special parameter in the Play Treatment pane
is Fuz (see above), and the Region pane changes entirely, becoming the Wave pane.
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The Wave Pane

As you can see, all the numericals, except for
Tun, now have different names.  Since Wavetable
Zones don’t read from the Sample Buffer, Stt and
Len are no longer needed.  In the Wave pane,
you choose two waveforms to use, and select an
envelope that will determine their relative balance.

Src (source).  Clicking on this numerical will present a popup menu
of the available tables, or give you an option to make a new
one.  The table you select here will be the first waveform
heard when you activate the Zone, or the Source wave.

Dst (destination).  This works identically to the Src parameter.  The
table chosen here, the Destination wave, will be averaged
with the Source wave, in a proportion determined by the
selected Env.

Since Release is
triggered by the

deactivation of the
Zone, you will only hear

the complete return of
the Zone to 100%

source if the release on
the amplitude envelope

is at least as long as the
release on the envelope

chosen in the Env
menu.  Conversely, if

you want it to end with
all or part of the

destination wave still
audible, make sure the
amplitude release time

is shorter.

Env  (envelope). In this numerical, you select an envelope which will
determine the timing and ratio of the two wavetables.  In a
Wavetable Zone, an envelope functions somewhat
differently than it does when used to control amplitude.
When the Zone is first activated, you will hear 100% of the
Source wave.  Over a period of time determined by the
attack length of the envelope, the Destination wave will be
added to the source, until at the end of the attack, you will
hear 100% of the destination wave.  The Decay time will
determine the period it takes to reach the Sustain level.  This
is not a volume level, but a ratio setting between the two
waves.  When Sustain is set to 0, you will hear only the
Source wave.  At 100, only the Destination.  Values in
between will give you a mixture of the two waves. Release
time will determine the rate at which you return to hearing
100% of the Source wave.

Using CTabs as wavetables

When using a Playback Zone in Wavetable mode, LiSa is treating the chosen tables as lookup
oscillators.  This means that the tables used are treated like very small sample buffers, and the shape
of the table is effectively a waveform.  The shape of the table thus changes the timbre and amplitude
of the Playback Zone.  Some things to remember about using CTabs as wavetables:

� The full table size is always used, even if you can’t see it.  If you try using a table with a
domain smaller than 512, the Wavetable Zone will read the entire table anyway.

� The flatter your table is, the less amplitude you will get.  The difference between the
minimum and maximum values of your table will have more of an effect on volume than
timbre.  If you make 2 sawtooth waveforms, both with a minimum value of zero, and one with
a maximum of 127 and the other with a maximum of 64, you will notice a relatively small
difference in timbre, but a significant one in volume.

Once you have chosen one of the Playback modes described above, which determines the basic
nature of how the sample will be treated as it is played, you use the menus available from the other
Function Mode buttons to determine details of Zone behavior and MIDI response.
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Advance Mode

Sets the start point for each activation of the sample.

Step Mode.  In this mode, the sample will begin playing back at the
place it left off the last time it was activated.  If its region is
moved via MIDI, it will not retrigger.

Restart Mode (default).  Every time the Zone is activated in this
mode, it begins playing at the absolute start point of the
Zone’s sample region.  If the sample region is changed via
MIDI while a Zone in this mode is active, it will automatically
retrigger from the beginning of the sample.

Activate Mode

� 

Determines the repeat pattern of the Zone (beginning at the
start point determined by the Advance Mode option):

Looping (default).  As long as the Zone is active, it will continue
playing over and over through its region.

Once.  In this mode, the sample will play as long as the Zone is
active, up to the end of the region.

Trigger .  A Zone in Trigger mode will play the entire region,
regardless of how long it is activated.  Note that this is
pointless to use in conjunction with Step mode, as you will
always find your ‘step’ ending at the end of the sample
region.

Due to the nature of Triggered playback, which stops dead at the end of a playback region
with no fadeout or looping built in, it is advisable to leave a bit of silence at the end of a
soundfile that you plan to use with a Zone in Trigger mode, or you may get clicks at the

end.

Voice Allocation
Determines the priority of the voices assigned to the Zone.
For more details see Appendix 2: Voice Allocation on p.
112.

Free Allocation (default).  When LiSa runs out of voices, i.e., when
there are more MIDI commands for activating Zones than
the computer’s processor can handle, Low priority Zones will
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drop their longest-playing voice in order to free up a voice for
the new note on.  LiSa looks for the longest-playing voice in
all active low-priority zones to turn off.

Never Replace.  High priority Zones never give up their voices for
anything, including other high-priority Zones and Record
Zones.  Beware of overusing this setting, especially in
conjunction with any kind of sustain.  Once a high Priority
Zone has received a note on, it will never give it up, even if
that means that no new notes can be produced or recorded.

8/16/32 Voice Max.  These three settings limit the number of
voices for that Zone.  New Note On messages will drop the
oldest voice for that Zone.  Note that the if the Max Voices
parameter in the Lisa Settings dialog is set to a number
lower than the Voice Max value of a Zone, the global setting
will take priority.  For example, if you have Max Voices set to
22 in the LiSa settings dialog, a Zone set with Voice Max set
to 32 will play no more than 22 voices.

Zone Parameter Control

Enables or disables the connection between the
Zone and the MIDI parameter controls as set in the
Assignment window.  This is useful when editing
Zones, to avoid sending unnecessary MIDI to a
Zone, and when selecting Zones that you do not
want to be affected by MIDI in performance.

Enabled (default).  MIDI input can affect Zone parameters.

Disabled.  MIDI cannot affect Zone parameters.  The Zone can still
be activated through the keyboard, and velocity will still
affect volume, but no controllers or modulators will affect the
Zone.

Modulator Running Mode

Determines the start point for LiSa’s internal
modulation functions (see Parameter Control  p. 84
for more on modulators).  In Restart mode, the
waveshape or table that determines the shape of
the modulation will start from the beginning each
time the sample is triggered.  In Free Run mode,
the start location in the table is unpredictable.

AAAAmmmmpppplllliiiittttuuuuddddeeee    EEEEnnnnvvvveeeellllooooppppeeeessss

When listening to samples
from the Sample Editor,

LiSa uses envelope Nr. 1
by default for amplitude, so

it is wise to not put long
attacks or decays on this

envelope if you want to
audition your samples

properly.

All Playback Zones have an amplitude envelope -- a
controller for the amplifier that determines how
quickly each sound reaches its maximum volume,
and how long it takes to die out after you stop
playing the note.  When a Playback Zone is created,
it comes with one ready-made envelope, called ‘On
Off,’ which immediately turns the sample to full
volume when you activate the Zone, and
immediately turns it off when you deactivate it.  For
more on envelopes, see p. 51.
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FFFFiiiilllltttteeeerrrrssss

New In v. 2.5:
Expanded Filters

All playback zones have an optional MIDI-
controllable filter, which can be viewed by clicking
the blue menu triangle labeled filter in the lower-left
corner of the Zone Editor. Filters have four possible
modes: Lowpass, Bandpass, Highpass, and
Formant.

When using filters, keep in mind two things:
1: They are computationally expensive, and the more filtered zones you have activated,

the fewer overall voices you will be able to sound simultaneously.
  2:  To get the best results from your filter, always use Best Playback quality in Presets

with filtered Zones.

� Lowpass filters allow frequencies below the cutoff
parameter to pass through, eliminating high frequencies.

� Bandpass filters only allow the frequencies at or around the
center frequency to pass.

� Highpass filters allow frequencies above the cutoff
parameter to pass through, eliminating low frequencies.

� The Formant filter is a bank of 3 bandpass filters with a set
width.  This is by far the most computationally expensive
filter to use.

When a new playback Zone is created, the filter is off by default.  To activate it, click on the On radio
button.  Filters have two parameters:

Freq.  In the case of lowpass and highpass filters, this parameter
sets the cutoff point.  In a bandpass filter, this parameter
controls the center frequency.  Scaled 0-99. In a formant
filter, this parameter controls the distance between the three
filters.

Q.  For all filters except Formant, this parameter controls the
steepness of the filter cutoff.  Scaled 0-99, higher values
increase steepness, decreasing the bandwidth, and thus the
resonant qualities of the filter. ‘Q’, by the way, stands for
‘quality’ and is a hangover from the old analog days of filter
design.  In the case of Formant filters, this parameter
controls the distance between the center frequencies of the
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three filters.  The real Q of these filters is fixed.

These parameters can be controlled both by MIDI (parameters available, like all others, in the
Assignment window) and by envelopes, which can be selected from any envelopes in the Envelope
Library.  The depth of the effect of the envelopes can be adjusted from the numericals labeled Dep.
Note that unlike the amplitude envelopes for playback Zones, these envelopes may not be switched
via MIDI.  The effect of the envelopes and the other parameter controls are additive.
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PPPPaaaatttttttteeeerrrrnnnn    MMMMooooddddeeeessss

The Pattern modes are one of LiSa’s most powerful playback options.  A Zone in Pattern mode uses
custom templates of playback pointer movement through the Sample Buffer, which can be controlled
via MIDI.

Except for their sound quality the two types of Pattern modes function identically.  Patterns function in
Zones in a way analogous to envelopes: you design a set of patterns in the Pattern editor, store them
in a Pattern Library, and call them up via the special parameter numerical or MIDI.

A pattern is comprised of one to ten elements; each comprised of a set of instructions to the play
pointer, the thing in the computer that indicates the exact location in the Sample Buffer one is hearing
at any given moment.  When a Pattern Zone is active, it will execute the elements one by one, in an
order determined by the Jump to: parameter.

TTTThhhheeee    PPPPaaaatttttttteeeerrrrnnnn    EEEEddddiiiittttoooorrrr

To create a new pattern, select Pattern Library from the Windows menu, (or type Cmd-3) and click
on New.  The Pattern Editor window can be opened by selecting the Pattern Window item in the
Windows menu or by double-clicking on a Pattern in the Pattern Library.  Creating a new Pattern will
also automatically open the Editor.  In this window you can specify the precise movements of the play
pointer through the Pattern’s Region.  Before discussing the Pattern mode parameters in detail, a few
general points:

� When in ‘show length in samples’ mode, the Pattern editor counts in absolute number of
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samples.  Remember that when you have selected Show Size in Samples, you normally see
time represented in the Coarse aspect of a numerical in kilobytes (kB), or groups of 1024
samples in the Zone Editor.  The pattern editor, on the other hand, shows you the absolute
number of samples -- there is no coarse setting.  400 means 400 samples (circa .009 of a
second) not 400 kB of samples (9.287 seconds).  Thus when viewing your Zone Editor in
Show Size in Samples, it will not directly relate to what you see in the pattern editor.

� Any movement of the play pointer you specify will always be limited to the size of the Zone’s
sample region.  This will become clearer as you read on, but for now understand that any
movement you specify that would push the play pointer out of the Zone’s region will be
wrapped around to the beginning of the sample region.  A pattern will never go outside of its
Sample Region, however you describe its movements.

� A pattern retriggers when moved based on its Advance mode.  Like playback regions, when a
Pattern Zone’s sample region is moved via MIDI, it will start again from the beginning of the
pattern if it is in Restart mode.  In Step mode, it will simply continue the pattern from whatever
point it left off at the last time it was activated.

PPPPaaaatttttttteeeerrrrnnnn    PPPPaaaarrrraaaammmmeeeetttteeeerrrrssss
It is possible to change parameters in the Pattern Editor while listening to your sample.  You cannot,
however, reduce the number of elements in a pattern while a voice is activated.

The offset starts from
the beginning of the

Zone if it is in Restart
mode. In Step mode, it
will naturally continue

from where it left off
last.

Offset.  This parameter determines how many samples the pointer
skips over at the beginning of each pass of the element.
Every time the element plays, it takes the offset and adds it to
the current pointer location before starting to play. Offset's
range (in either direction) can be as large as the entire
Sample Buffer, although as mentioned above, it will always
wrap around within the size of the Sample Region. Default is
0.

Length. This determines the actual number of samples that the
pointer plays when executing the element. Whatever your
other processes within the element are, this is what you will
actually hear. Default is 0.01 seconds.

A good rule of thumb to keep in mind when designing patterns is the thousand-sample
rule.  As long as your Offset and Samples parameters are under 1000 or so, (about .02

seconds) the transformations you put into your pattern will be perceived basically as pitch
and timbral changes.  Above this threshold you start to hear more rhythmic chunks of

sound.  The exact behavior will depend on the sample and the relationship between
these two parameters.

Repeats. This determines the number of times the area defined by
Length will be repeated in each pass. Minimum is 0 (default),
meaning it plays through only once. Maximum is 9999.

Pitch Shift. This numerical alters the frequency of the samples being
played, above and beyond any other pitch alterations that
may be taking place. It is a frequency-based parameter, not
pitch, and is thus logarithmic rather than linear. When this
parameter is set to zero, it is heard at the pitch as established
by the keyboard and the Tun numerical. When set to its
maximum value (100) it is played back at just under twice the
frequency of its original pitch, which is to say (just shy of) one
octave higher. On the other hand, when you go below zero,
the pitch drops much faster. At -50, you are playing it back at
half the frequency, or one octave lower, and at -75, an octave
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below that. At it �s lowest setting, -99, you �re playing very
low, about 6 octaves below your original pitch. Default is 0.

Amplitude. This sets the amplitude of the element, relative to the
overall amplitude of the Zone as set in Lev.  Maximum is 100
(unity with Lev); minimum is 0 (no sound). Default is 100.

Panning. Controls location of the sound in the stereo field. -100 is
hard left, 100 hard right. 0 (center) is the default.

Play Direction. Clicking on this numerical toggles between a forward
(-->) and backward (<--) direction of play. Play direction has
no effect on the Offset parameter. Default is forward.

Jump To. This box functions as a gateway from one element to the
next. Clicking on it reveals a popup menu with the following
options:

� New Element. Adds a new element to the bottom of the list.

� Delete Element. Deletes current element from the list. You
cannot delete element number 1.

� Element <number>. Selecting one of these assigns the next
element the pattern will jump to. Any active element may be
chosen, including itself.

CCCCoooonnnnttttrrrroooolllllllliiiinnnngggg    PPPPaaaatttttttteeeerrrrnnnnssss    wwwwiiiitttthhhh    MMMMIIIIDDDDIIII

Linking controllers to patterns

To assign a pattern element to MIDI, select any of the four Pattern Control options in the Parameter
menu in the MIDI pane of the Assignment window, and connect it to a controller. This procedure is
explained in full in Parameter Control on p. 84.

Due to the nature of pattern
Zones, all parameter control is

treated as Channel Controllers.
For an explanation of the

distinction between voice and
channel controls, see Channel
and Voice MIDI Control, p. 87

The exact function of MIDI control patterns is set at
the bottom of the Parameter Editor, in the MIDI
Controllable Parameters pane. Each of the red
numbers at the side indicates one of the Pattern
Parameter Controls available in the parameter menu.
Thus, if you link Pattern Parameter Control 2 to
Aftertouch, you would set exactly what effect
aftertouch has in the top-right set of numericals.
There are four columns for settings:

Parm. Clicking on this numerical will reveal a popup menu containing
the seven pattern parameters. Select the one you want to
use.

Elem. This numerical selects which of the pattern elements will be
affected. You cannot change one parameter for all elements
in a pattern, only one element per controller.

MIn and Max. These numbers refer to the parameter values
corresponding to the minimum and maximum values of the
controller you are using.  For most parameters, the MIn and
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Max have the same meaning they would in the numericals
for setting the given parameter. The MIDI control range of 0-
127 is interpolated between the Min and Max values. (The
exception to this is the Play Direction parameter, which can
only be set to 0 or 1. Zero (which is the result of any MIDI
control value less than 64) makes the element play
backwards, and one (for any MIDI value 64 or over) plays
forwards. Min may be a larger value than Max.

SSSSmmmmooooooootttthhhh    VVVVeeeerrrrssssuuuussss    RRRRoooouuuugggghhhh    PPPPaaaatttttttteeeerrrrnnnnssss
There are two different types of Pattern Mode: Smooth and Rough. All of the functions described
above work identically in both. The difference is that the Smooth Pattern mode has special algorithms
built in to eliminate clicks and pops often heard while jumping around in a sample, and the Rough does
not. Depending on the particular Pattern and sample you are using, one may sound better than
another, or they could sound more or less the same. Rough mode often gives an extra kick to the
upper harmonics that gives the sample a bit more presence. Another difference between the two is that
the Rough mode is one of the fastest playback algorithms in LiSa, whereas Smooth, because of the
time it spends doing corrections, is one of the slowest, and puts more stress on your voice allocation.
So if you have a slower machine, and you’re concerned about your number of available voices, use
Rough mode when you can.

UUUUssssiiiinnnngggg    PPPPaaaatttttttteeeerrrrnnnnssss    iiiinnnn    aaaa    ZZZZoooonnnneeee
Once you have made a pattern or two, you are ready to use them in a Zone.  Create a new Playback
Zone and set the Playback Mode to Pattern.  The Play Treatment pane in the Zone editor will look like
this:

The only parameter here we have not seen before is
the Pat parameter.  Clicking on the numerical will
show a menu of the patterns you have created.  Select
one, and that is the pattern the Zone will use.
Alternately, you may drag a Pattern from the Pattern
Library to this numerical.

It is also possible to switch dynamically between Patterns, much as one does with Envelopes.  For
more on this, see Pattern Controls, p. 91
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RRRReeeeccccoooorrrrddddiiiinnnngggg    aaaa    SSSSaaaammmmpppplllleeee

Although there is a great deal one can do with LiSa only playing back sampled sounds from disk, it
was primarily designed for live situations in which one can sample another instrument live, process
the sample, and play it back.  This chapter covers techniques for recording samples into the Sample
Buffer in real time, which are done with Record Zones.  Many of the modes used in the Record
function are identical to those in Playback.  There are some small variations, however, and at the risk
of being repetitive, they will all be described in full.  For recording while editing your Setup see p. 44

AAAA    FFFFeeeewwww    TTTThhhhiiiinnnnggggssss    AAAAbbbboooouuuutttt    RRRReeeeccccoooorrrrddddiiiinnnngggg    iiiinnnn    LLLLiiiiSSSSaaaa

Clipping and Overdrive
Digital clipping is particularly ugly, and there are possibilities within LiSa to create certain distortion
and overdrive effects, as we shall see.  We advise that you record your samples as cleanly as you
can, and create any distortion you want within LiSa, using the Fuz playback parameter described in
the previous chapter.

Inputs

LiSa now operates fully in stereo, and both input channels record independently.  That is to say that
you can input either a stereo input or two independent mono inputs into LiSa.

If you are using two independent mono sources, and want to save that material for later, please
remember that LiSa’s sample editor will not edit left and right channels independently.  You will need
a third-party sample editor which can separate an interleaved stereo file into two mono files, which
you can then edit separately.

If you are using an ASIO soundcard with more than two inputs, you can select which input pair the
Record Zone is listening to (and which it plays back on) using the new Input and Output menus.  See
below for details.

Recording from CD

It is possible also to record from your computer’s built-in CD-ROM player.  By selecting CD as the
audio input in the Audio Input Select dialog, LiSa will record directly from the CD player.  You do
not need to use Apple’s Sound control panel.

CCCCrrrreeeeaaaattttiiiinnnngggg    aaaa    RRRReeeeccccoooorrrrdddd    ZZZZoooonnnneeee

There is no particular reason to
assign a Record Zone to more

than one key -- The key number
you record from will have no

effect on playback pitch.

We assume that at this point you are clear on the
basic procedures for creating a Zone and assigning
its keyboard range.  If you aren’t, see Creating a
Zone on p. 23.

DDDDeeeeffffiiiinnnniiiinnnngggg    tttthhhheeee    ZZZZoooonnnneeee’’’’ssss    FFFFuuuunnnnccccttttiiiioooonnnn
The Zone you have just created should be visible in the Zone Editor window.  The default function for
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new Zones is Playback, so the first step is to make it a Record Zone.  Go to the Zone Function button
(the leftmost icon in the top pane) in the Zone Editor, click on it and select Record Zone from the
pop-up menu.  The Zone Editor looks slightly different from a Playback Zone, but most of the settings
are similar.

The Information Pane

Most of the settings here will already be familiar to you.  If you are using a soundcard with multiple
inputs and outputs, you will note one difference: popup menus labeled Input and Output.  The Input
numerical controls which stereo pair the Record Zone is recording, and the Output, obviously, sets
the stereo pair that the Zone plays back from.  Remember that Record Zones only output sound if
they are in Looping mode.

The Region Pane

The numericals in this section of the Zone Editor define the sample region of the Zone, and set an
activation threshold for recording.  The first three function exactly as they do in Playback Zones.

Stt (absolute start time).  Sets the absolute start time
of the Zone’s region.

Len (length).  Sets the length of the Zone’s sample
region.

Record Zones will self-limit.  That is to
say that they will not go past the end of

the Sample Buffer -- recording into
some random spot in your computer’s

memory would crash your machine.
(This does not apply to all Zone

functions).

Mvr (movement range).  Sets the area within the
Sample Buffer that the Zone can move in
when controlled by MIDI.

TOn/TOf (threshold on/off). This is a dual numerical.
TOn is normally visible – to view and edit
TOf, press the Shift key.  These parameters
(range 0-127) set the relative input level at
which the recording process will be initiated
and ended.  At 0, it will record all input, at 64
it will record only signals that are more than
half of the maximum input, and at 127 it will
record hardly anything.  If it is set to any
non-zero value, the Record Zone will only
record if it is both activated from MIDI and is
receiving a signal above the threshold.
When the input drops below the level set in
TOf, it will pause the recording process.
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There are two things to keep in mind about using a threshold.  Firstly, attack and decay
times are very short.  One sample with amplitude above TOn will initiate recording, and

about 11 milliseconds or so of sound below the level of TOf will deactivate it, depending on
your machine.  Secondly, the threshold value takes priority over all mode settings.  As long

as the signal is below TOn, the record pointer does not move.  This applies to all modes,
including Trigger mode.  In order to record a whole Zone in Trigger mode, it is necessary to
set TOf to 0.  In a Zone in Loop mode, for example, you might hear the sample playing, but

you will not record exactly onto what you hear -- you will record beginning at where it last
stopped.  You can check the activity of the record pointer in the Status window by selecting
the Show Current Sample Pointer option in the Options menu.  The current location of the

sample pointer will be displayed in the System Messages pane of the Status Window.

DDDDeeeeffffiiiinnnniiiinnnngggg    RRRReeeeccccoooorrrrdddd    MMMMooooddddeeeessss

The Record Mode Icons

Clicking on each of the 5 mode buttons will reveal pop-up menus showing the possible record
options:

The Recording Mode pop-up Menu

� 

This covers what happens to the old sound (if any) in
the sample region at the moment of recording.

Replace.   (Default).  When the Zone is in this mode, whatever
sound was in the Sample Buffer prior to the recording will be
overwritten.  If the Zone is in Looping mode, this will behave
like an Overdub Zone.  To avoid hearing older material, keep
the Fdb parameter to 0.

Overdub.  In this mode, the newly recorded sound is added to
whatever sounds were present in that location in the buffer.
The original sound will remain.  Please note that this is
purely additive and there is no limiting, so repeated overdubs
will eventually lead to distortion.  This is not necessarily a
bad thing, but something to be kept in mind.  The amount of
the original material you will keep depends on the Feedback
setting in the Record Treatment pane.

The Advance Mode pop-up Menu

� 

Sets the record start point for each activation of the
Zone.  These work on the same principle as the
Advance Mode items in Playback Zones.

Step Mode.  In this mode, the sample will begin
recording at the place it left off the last time it
was activated.  For example, if a Record
Zone has a sample region 5 seconds long,
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and you record in 3 seconds of sound, the
next time you activate the Zone, it will begin
at 3 seconds plus 1 sample, leaving your first
3 seconds of samples untouched.
Depending on the Activate Mode (see The
Record Treatment Pane, p. 72), it will either
continue cycling through its portion of the
buffer, or step through until the end of the
sample region.

Restart Mode (default).  Every time the Record
Zone is activated in this mode, it begins
recording at the absolute start point of the
Zone.

The Activate Mode pop-up Menu

� 

Determines how the record pointer will move
through the Sample Buffer when it is activated
(beginning at the start point determined by the
Advance mode option).

Looping (default).  As long as the Zone is active, it will continue
recording over and over through its allotted area in the
Sample Buffer.  Regardless of the Recording Mode, a Zone
in loop mode will overdub material from that particular
activation, in an amount determined by the Fdb parameter
(see above).

Once.  In this mode, the sample will record as long as the Zone is
active, up to the maximum length of the Zone.

Trigger.  A Zone in Trigger mode will record the entire sample
region, regardless of how long it is activated.  Thus, a short
keystroke can initiate the recording of a very long sample.

The Auto Save Session pop-up Menu

Handles direct saving of samples to disk.  This is
discussed in more detail in Load Session Zones, p.
79

Disabled (default).  The Zone will not auto-save.
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Recording while editing:
If you activate a Record
Sample Zone by option-

clicking on the virtual
keyboard, instead of via
MIDI, it will not save the
recording as a session.

Once the recording is
finished, LiSa will

prompt you to name
and save the soundfile

as one would any other
file.

Enabled.  For samples to be auto-saved, this must be enabled and
the Auto Save Recording Sessions item in the Options
menu must be enabled (checked).  If only one or the other is
on, no auto-saving will occur.  (This is in order to make it
easy to disable all auto-recording zones when editing your
Setup.)  When both of these are enabled, it means that
every time a new recording is made into the Zone, it will be
saved immediately to disk.  Make sure you know when you
are using this, or you can fill up your disk awfully fast!
Recorded samples are immediately available for reloading
into LiSa using Load Session Zones.  When you quit LiSa, it
will create a folder in the same folder that contains your
Setup file.  This folder will be named with the format ‘<date>
Sessions <time>’.  Saved soundfiles are in SDII stereo
format, 44.1 kHz.  For more on this, see Managing Sessions
on p. 81.

The Zone Parameter Control pop-up Menu

� 

Enables or disables the connection between the Zone
and the parameter controls as set in the Assignment
window.

Enabled (default).  MIDI input can affect Zone parameters.

Disabled.  MIDI cannot affect Zone parameters.

TTTThhhheeee    RRRReeeeccccoooorrrrdddd    TTTTrrrreeeeaaaattttmmmmeeeennnntttt    PPPPaaaannnneeee
The variables in this pane control input, output and
feedback levels for the sample as it is being
recorded.  All of these are also controllable via
MIDI from the Assignment window.

Out/Pan (output level/panning). This is a dual numerical.  Out
controls the overall level of the Zone.  Range is 0-100, with 0
meaning no output, and 100 meaning full sample volume
level.  This value does not affect the sample itself; only its
output level.  Default is 100%.  Pressing the Shift key will
change it to the Pan parameter.  Range is -100 to 100, from
100% left to 100% right.

When you record a
sample in Looping and

Overdub mode, you will
hear the old material

every time through
before it is recorded

over.  If you do not want
to hear it, set Out to 0.

Inp    (input level/channel).  This dual numerical sets both the
attenuation of the signal input as it is recorded, and the
channel which the Zone will record from.  Note that this
value does not affect the level of the incoming signal -- it
cannot be used to control clipping, you need to do that at
your sound source.  This parameter, being MIDI-controllable,
is best used when attenuating input in live situations.
Default is 100%.  Holding down the Shift key will turn this
numerical into a channel select, with the options of Left,
Right, or Both.  When Both is selected, and sound is
recorded at only one of the two stereo channels, the Sample
Buffer will only display the channel that is receiving sound
input.  If either Left or Right is selected, the mono channel
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will be duplicated into both sides of LiSa’s stereo buffer, thus
giving a two-channel mono sample.

Fdb    (feedback).  If the Zone is in Loop mode, this parameter will
effect how much of the previous sample you hear.  If this
value is anything higher than 0, some amount of the
previous signal will be mixed in with the new signal as the
buffer is re-recorded, with the amount depending on this
setting.  Range is 0-100% of the original signal.  Default is
100%.

Ovd   (overdrive).  Overdrive is an extension of the feedback control
-- rather than attenuating the previous signal, it amplifies it.
After repeated looping, you can get some rather interesting
distortion effects with Overdrive.  You can think of it as
Feedback values of more than 100%.  In order for Ovd to
take effect, Fdb must be set to 100.  Default is 0.

RRRReeeeccccoooorrrrddddiiiinnnngggg

� 

Once you have defined your Zone, you’re ready
to record sound into it.  Information about the
recording process may be found in the Status
window.

The Input Level monitor shows the input level to LiSa through your
computer’s or soundcard’s analog-digital converters.  This
should never go into the red -- that means annoying digital
clipping is occurring, and you will have to readjust your
levels either from your mixer or in the System Settings dialog
box (p. 16).  The Input level display has a separate monitor
bar for up to eight possible inputs.

The Rec monitor turns magenta if a Record Zone is currently active.
Remember that this does not necessarily indicate if
recording is actually taking place.  When TOn is above 0, it
will only record when the level of your input exceeds the
threshold values.  Selecting the Show Current Sample
Pointer option will allow you to see if recording is actually
taking place.

The Sample Buffer pane will show a graphic representation of the
samples currently in RAM.  When you record, you will see
your sample appear in the buffer after recording is
completed, or if you are in Looping mode, after each loop.

The Voices monitor indicates how many voices are currently active.
The number below the red button indicates the number of
voices recording, below the green button, the number of
voices playing back.

When recording is active, a message will appear in the System
messages pane.  If Show Current Sample Pointer is
selected in the Options menu, it will show the current point
of the sample pointer as well.

AAAAccccttttiiiivvvvaaaattttiiiinnnngggg    yyyyoooouuuurrrr    RRRReeeeccccoooorrrrdddd    ZZZZoooonnnneeee

You will never hear your recorded
sound directly as you record it.  In

To initiate recording, simply press the key on your
keyboard that is assigned to your recording Zone’s
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Overdub mode you will hear the
original sample, and if you are

looping and overdubbing, you will
hear the last recorded version. In

Once or Trigger mode, you will
hear nothing as you record.

keyrange.  Assuming you are not using a threshold,
recording will commence immediately, in whatever
fashion you have set in the Zone Editor.  Once you
have recorded, you can play the sounds using
Playback Zones.
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FFFFiiiilllleeee    MMMMaaaannnnaaaaggggeeeemmmmeeeennnntttt    ZZZZoooonnnneeeessss

There are three special kinds of Zones devoted to dealing with soundfiles: Static and Dynamic Load
Sample Zones, and Load Session Zones.  A Load Sample Zone is designed for loading samples
that have been previously recorded.  Load Session Zones are for loading samples which have been
recorded live.

LLLLooooaaaadddd    SSSSaaaammmmpppplllleeee    ZZZZoooonnnneeeessss
There are two varieties of Load Sample zones, Static and Dynamic.  They both serve the same
basic function of loading soundfiles from disk into the Sample Buffer, but with different modes of
operation.  Like all Zones, Load Sample Zones are spawned by creating a new Zone in the Zone
Library and selecting Static Sample Load from the Function Icon menu in the Zone Editor.  Once
you’ve done this, you’ll notice that it looks rather different from the Zone Editor windows we’ve seen
so far.

Static Zones

Firstly, you will notice that no Mode Icons remain, and there are no CTabs next to the Stt and Len

numericals.  This is because that except for keyboard activation (meaning you can activate

the Zone with a midi note-on event), Static Load Sample Zones are not MIDI-controllable.
The Load Sample File pane on the bottom right is where you select the sample to be loaded.
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Selecting a Sample to Load

Like Record Zones,
Load Sample Zones

need only be assigned
to one key on the

virtual keyboard --
their keyrange does
not affect playback

pitch.

To select a sample to load, drag the name of the
desired soundfile from the Sample Library window
into the Name box in the Load Sample File pane.
The name of the selected file will appear in the
Name box in the Zone Editor Window. In addition,
the Zone length will automatically be adjusted to
the size of the soundfile, and the Zone will
automatically be renamed with the name of the
sample it is loading.

Quick load sample creation

Don’t forget: in these drag-and
drop file creations, you can

tweak the Stt and Len
parameters as you need to after

creating the zones

If you drag a soundfile entry from the Sample
Library to the Zone Library, it will automatically
create a new Static Load Zone.  The Zone will
have the same name and length as the soundfile,
with its start point at the beginning of the Sample
Buffer.

Loading a Sample

When you activate a Load Sample Zone, it will load the soundfile from disk into the sample region
specified by the Stt and Len numericals in the Region pane.  Some things to keep in mind about
loading samples from a Static Zone:

� Sample Loads are Destructive.  That is, whatever material is in the Sample Buffer already
in the region of the load Zone will be overwritten.  It is not possible to mix a statically loaded
sample with sound previously existing in the buffer.

� Region Size.  The amount of time you assign to your sample region in the buffer need not
be the same size as the sample.  If the region is larger than the sample to be loaded, it will

load the entire sample, and leave any other material inside that region untouched, unless

you have selected the ‘Clear Region before load’ button.  If the region is smaller,
it will load as much as will fit in the region, starting from the beginning of the soundfile.

When you attempt to load a sample you will get a notification (in the Sample File Messages pane in
your Status window) indicating if the sample was successfully loaded.
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Sample Load Options

There are two options available for loading samples:

Notes on the Play Stereo File option:
1.The numericals in the Region pane are

irrelevant.  2.  Only one file can be played
this way at any one time.  3.  If you are

interacting with the graphical interface of
LiSa while the file is playing, especially

pulling down menus, the file may
momentarily hang, but it will continue to

play back as soon as the screen
interaction ends. 4. Stopping a file as it is

playing will turn off all MIDI notes active
on this channel, so if you might be using

that feature, put your load zones which
will play files directly on a separate MIDI

channel.

Play Stereo File.  NB:  This option will only be
available if you have loaded a stereo file
into this zone!  When this option is
selected, the sample will not be loaded into
the sample buffer, but will simply be played
direct from your hard disk, without changing
the material in the buffer.  This makes it
possible to play samples that are much
longer than the Sample Buffer.  As the file
is playing, you can see its progress in the
Stereo File Progress Bar in the Status
window.  The velocity of the note that
activates this Zone will determine its initial
level.  The playback volume is also
adjustable via the Output Level parameter.
You can stop the playback of such a file at
any time by sending LiSa an All Notes Off
message, which is a value of 0 on controller
number 123 of the MIDI channel to which
the Load Zone is assigned.

Clear Region Before Load.  This option is mostly
useful for erasing space in the Sample
Buffer.  As mentioned above, under normal
circumstances, if the load region is larger
than the soundfile, the rest of the region is
normally left untouched.  If the Clear
Region Before Load option is selected,
the part of the region not containing the
soundfile is cleared.   For example, if you
have a Static Load Zone that is 10 seconds
long, and a 5-second sample in it, the 5
seconds after it in the Sample Buffer will be
cleared.
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Dynamic Zones
Dynamic Load Sample Zones work on a similar principle, but have more options available.

Movement

Dynamic Load Zones can be moved via MIDI, like a Playback or Record Zone, with a corresponding
CTab.  The Mvr parameter will set the movement range.  Length may not be altered, or even set –
the size of the Zone automatically adjusts to that of the sample being loaded.

Multiple samples

Like a Static Load Sample Zone, samples are added by dragging them from the Sample Library.  Up
to eight samples may be dragged into the Zone.  Moving them up and down in the window will
change their load order.  To see why you might want to do this, see below. Dynamic Sample Load
Zones have two Modes, Immediate and Dynamic.  Each Mode has one or more available options,
which may be selected in the Options pane.

Loading modes

Immediate Load.

This is the default setting of dynamic Zones.  When the immediate load radio button is selected, all
samples in the Sample List pane are loaded in top-to-bottom order.  An activation of any length will
load the entire sample collection.  (Like the Static Zones, you can think of this as being in Trigger
mode.)  When in this mode, there is one option:

Merge.  When this is selected, the samples to
be loaded will be mixed with the
samples already present at that location
in the buffer, like a record Zone in
Overdub mode.  The Level numerical
controls the amount of the new sample
to be added to the old.  Continued
adding of samples on top of each other
will create the same kind of distortion
made by the Fuz playback parameter,
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not digital clipping.

Dynamic Load

In Dynamic Load mode, the sample is loaded only as long as the Zone is active.  If you have two 10-
second samples, and hold the key controlling the Zone down for 5 seconds, only the first 5 seconds
of the first sample in the collection will be loaded.  The options for this Mode are rather complicated,
and build on one another:

Listen.  In Dynamic mode, you will probably
always want to have this button checked.
This plays the sample as it being loaded
into the buffer.

Offset.  When Offset is selected, the velocity of
the note on event that activated the Zone
is used as an index to select which
sample is to be loaded first.  The full
range of the velocity is divided among the
number of samples in the collection.  In
the example above, a gentle press on the
keyboard will load the collection starting
with the sample ‘single break’, a light
medium one ‘wrong metallic, a more
determined one “x.kyama’, and so on.
The samples will always be loaded from
the beginning of the soundfile, and will
stop loading when the Zone receives a
note off.  Once one sample is finished, it
will start loading the next one in the list.

Only One. Only available when Offset  is
selected.  When Only One is selected,
the Zone will only load one of the
samples in the collection.  In the above
case, with Only One selected, a low-
velocity note on would load ‘single break’
alone, no matter how long the key was
held down.

Load Session Zones
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There is another way to record and play back live samples, using Sessions.  When using a Record
Zone and then playing it back you are only dumping sound into the buffer.  Using Load Session
Zones, you can save any number of samples when recording live, and then load them at a later time
during your performance.  To use Sessions in a live performance:

� Enable Auto Save Recording for one or more recording zones.  This will automatically save
whatever your Record Zone records to disk.

� Once you have recorded some live sounds, you reload the saved recordings into the
Sample Buffer with a Load Session Zone.

Once the sessions are loaded, you can play the sessions back with a Playback Zone.

Recording Sessions

Every time you activate a Record Zone that
has Auto Save Recording enabled, you

create a new Session.  Regardless of which
Record Zone you activate on which MIDI

channel, it is simply saved as the next
consecutively numbered Session.

Record Zones have the option of being set to
save recorded samples to disk or not, via the
Auto Save Recording function.  (For a full
explanation on how to auto save Recordings, see
The Auto Save Session pop-up Menu on p. 71.)
You can record as many sessions as your hard
disk can hold.  They will be saved into the same
folder as your Setup, and automatically named
‘Session 1,’ ‘Session 2,’ etc.  Sessions start
numbering themselves anew every time you start
up LiSa.

LLLLooooaaaaddddiiiinnnngggg    SSSSeeeessssssssiiiioooonnnnssss
A load Session Zone, unlike a Load Sample Zone, is best used over a large keyrange.  When you
activate a key in this Zone’s range, it will load a Session file based on the relative number of that key
in the Zone’s keyrange.  The first key in the range will load session 1, the second will load session 2,
and so on, depending on the number of sessions you have.  If you attempt to load a session that
does not yet exist, you will get an error message in the System Message pane.

There is a numerical in the Load Recorded Session pane called Start ID.  (The box next to the label
Name in this pane is display-only -- it is connected to the Start ID numerical.)  This allows you to
choose the session numbers that your keyrange will load into the Sample Buffer.

For example, you might want to have multiple Load Session zones on different MIDI channels.  If
your Zone on channel 1 has 10 keys assigned to it, they will default to playing back Sessions 1-10.
You can create a second Load Session Zone on channel 2 as well, and have it play Sessions
starting with number 11 by changing the Start ID numerical to 11.  The number shown in Start ID
will always be the Session number played by the ‘lowest’ key in the keyrange.

The note values of the keyrange you
assign to your Load Session Zone
will not affect their playback pitch!
This Zone only loads, it does not

play.

The effective number of sessions that can be
loaded is 1144.  The highest possible Start ID
number is 1024, and if you have a Load
Session Zone covering all 120 MIDI notes,
1144 is your maximum.  Also note that the
Sample Regions of these Zones cannot be
moved or resized via MIDI.

Session loads work just like Static Load Sample loads in other respects.  Loading a Session will only
fill the Sample Buffer up to the size of its Sample Region, regardless of the size of the Session file it
is loading, always starting from the beginning.  You will not hear a Session when it loads -- you need
a Playback Zone in order to be able to hear the Session.
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MMMMaaaannnnaaaaggggiiiinnnngggg    SSSSeeeessssssssiiiioooonnnnssss

Saved Session folders

If you are planning to save sessions, it is
very important to save your Setup BEFORE
recording any sessions.  Sessions recorded

by an unsaved Setup will appear in the
folder containing the LiSa application, not in

a sessions folder.  One will be created if
you save your Setup before quitting, but it

will be empty.  Should you find your
Sessions folder empty, check in the LiSa

application folder.

If you have recorded Sessions, they will be
automatically reorganized every time you
shut down LiSa.  When you quit, it will
create a folder in the folder that contains
your Setup file.  This folder will be named
with the format ‘<date> Sessions <time>’.
They are saved with the names ‘Session 1’,
‘Session 2’, etc.  These can then be
renamed as samples for later use, or
reloaded as Sessions in another
performance.

When loading Sessions, LiSa looks in the folder containing your Setup, and loads whatever it finds
there with the name ‘Session’ followed by a number.  This means that any samples can be loaded
as Sessions by naming them ‘Session <number>’ and putting them in this folder.  They could be
previously recorded sessions or any old samples that you’ve named in this format.  (This has no
particular advantage over simply making a bunch of Load Sample Zones with old session samples,
but you can do it.)  If you choose to use those Sessions again, as Sessions, you have to take them
out of the folder they were saved into.  LiSa will not look in folders inside the folder containing your
Setup.  During a performance, Sessions must be directly in the folder containing your setup.  After
quitting, LiSa automatically moves them as described above.

Warning:  If you have moved old sessions back into your Setup’s folder and record any new
sessions, LiSa will write over the old ones.  If you have old Sessions numbered 1-20 in that folder,
and record a new Session, LiSa will not record it as session 21, but will rather write a new file
entitled ‘Session 1’, deleting your old ‘Session 1’ in the process.

CCCCooooppppyyyyiiiinnnngggg    BBBBuuuuffffffffeeeerrrrssss
Another one of LiSa’s live performance abilities is the capacity to resample something that has
already been played and return it to the Sample Buffer.  This is done with Copy Buffer Zones.  (For
basic information about LiSa’s buffers and how to resize them, see p.  19.

These Zones only copy from
one buffer to another.  In order

to save any of this information to
disk, you have to save it from

the Sample Buffer with a Save
Sample Zone.

 If you are using ASIO, only the
content of output channel A can

Copy Buffer Zones can be set to copy either the
Output Buffer or the Process Buffer.  You toggle
between these two choices by clicking on the
Buffer numerical on the right-hand side of the
Zone Editor.  The Region pane contains
numericals for determining the size and location
of the Zone’s region.  As in Static Load Zones,
the sample region cannot be changed via MIDI.
The numericals in the Copy Buffer to Sample
Buffer Pane set the region of the Process or
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be copied back to the Sample
Buffer.

Output Buffer that is copied to the Sample
Buffer.

The Output Buffer
The Output Buffer is normally empty.  To copy it to the Sample Buffer, it must first be filled.
Recording is initiated by a MIDI control message, or by hitting the ‘S’ key on your Mac’s keyboard. It
accepts any value from a controller to trigger recording -- the controller number you set yourself, in
the LiSa Settings... dialog from the Global menu (p.16).  If you are using an ASIO device, please
be aware that only sound routed through output A is copied to the Output Buffer.

The Output Buffer Rec Start numerical is where you set the controller number.  Any number,

including zero, which you send from this controller to Lisa on the MIDI channel you have
designated as the System channel (see p. 16) will enable recording.  Recording will not commence
until some sound is produced.  Once that happens, the indicator above the rightmost of the two
Voices monitors in the Status window will turn from green to red.

This indicates that the Output Buffer is being filled.  It will turn back to green once the buffer is full.
There is no way to stop the recording process once it begins -- it is always in Trigger mode.  Once
the buffer is recorded, you have two choices.

� It can be saved to disk.  Select Save Output Buffer As… from the File Menu.

� It can be loaded into the Sample Buffer any time by activating a Copy Output Buffer Zone.

This process can be repeated at any time -- the old output buffer will be overwritten by the new
sounds.

The Output Buffer records everything that happens while it is being recorded -- including nothing, so
if there are silences in your performance, there will also be silences in your Output Buffer, and thus
also in your Sample Buffer when you copy the Output Buffer to it.
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The Process Buffer

New in v. 2.5:
The output buffer

is now stereo.

Unlike the Output Buffer, the Process Buffer continually
records LiSa’s output.  It is a circular buffer, meaning that as
new information is added, the oldest information is dropped to
make room for the new.  When LiSa is not producing any
sound, the Process Buffer is inactive -- it does not fill up with
silence.

When you copy the Process Buffer, you are copying some portion of the last few seconds of sound
(depending on the size of the Process Buffer and sample region) into your Sample Buffer.  This
makes it possible to record something live (in a record Zone), load it (Load session Zone), play it
back through some process (Playback Zone) load it again after it was processed by the last
Playback Zone (Copy Process Buffer Zone), and process it again through the same or another
Playback Zone.

Activating this Zone simply takes a part of the Process Buffer and copies it into the Zone’s sample
region, exactly like a load from disk.  You can also set the Start and Length of the portion of the
Process Buffer you copy, but since this is a circular buffer, you cannot predict with much accuracy
e x a c t l y  w h a t  s o u n d s  y o u  w i l l  g e t .
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PPPPaaaarrrraaaammmmeeeetttteeeerrrr    CCCCoooonnnnttttrrrroooollll

SSSSeeeettttuuuupppp
For the basics of connecting and configuring MIDI in LiSa, and for setting MIDI preferences, please
see MIDI Setup, page 15

PPPPaaaarrrraaaammmmeeeetttteeeerrrr    CCCCoooonnnnttttrrrroooollll    TTTTyyyyppppeeeessss

MIDI

MIDI is LiSa’s primary interface to the outside world, and in a performance situation most of your
manipulations of LiSa will be done via some sort of MIDI instrument.  LiSa gives you maximum
flexibility in assigning controllers to different parameters of the program.  There are six primary
functions of MIDI:

� Activating Zones.  This is done using note on and note off MIDI commands, much like MIDI
on a standard sampler.

� Moving and resizing the sample region of a Zone in the Sample Buffer.

� Changing Zone parameters such as panning or distortion.

� Controlling input and output levels of samples.

� Amplifying the current Zone.

� Initiating an Output Buffer recording.

MMMMoooodddduuuullllaaaattttoooorrrrssss
Zone Parameters can also be controlled using internal table-driven modulators.  Their operation is
explained in full below.  In all respects regarding Setup and connections to Parameters, they are
treated no differently from MIDI controllers.

AAAArrrrcccchhhhiiiitttteeeeccccttttuuuurrrreeee
Parameter Controls are connected to Zones in the Parameter Control pane of the Assignment
window.  This will always mean first selecting a Parameter to control, and then assigning it to a
Controller.  Controllers of both types are created in the Controller editor.  There is a Parameter
Library, but you cannot create new Parameters.  The number of Parameters in LiSa is fixed, and the
Library is there primarily for reference and drag-and-drop convenience.

Controllers, whether they are MIDI or Internal Modulators, are stored like all other data in a Library,
created in an Editor, and named with a name of your choice.

MIDI in LiSa is assigned to Voice Layers, and MIDI sent to a Voice Layer can affect all of the Zones
whose keyranges are in that layer.  It is possible to vary the way MIDI affects the various Zones on a
channel, or not have a Zone be effected by MIDI at all.  A MIDI input, typically a 7-bit value (0-127), is
assigned to a variable.  This could be sample region length, a degree of effects processing, or almost
any of the Zone Editor parameters.  Before this number is applied to the variable it can be passed
through a special table called a Control Table, or CTab.  These tables can be custom-designed to
map the normally linear values of a MIDI controller to some other set of values.  (See Tables, p. 46.)
You can see the MIDI input from your instrument in the MIDI Monitor pane of the Status window, or in
the Assignment window by selecting Display Last MIDI Event in the Options menu.
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The only exception to this structure is MIDI control of modulator parameters, such as speed and table
shape.  Modulators exist independently of any given Voice Layer, and MIDI control for these is set in
the Controller editor (see Editing Controllers, p. 87)

TTTThhhheeee    PPPPaaaarrrraaaammmmeeeetttteeeerrrr    CCCCoooonnnnttttrrrroooollll    PPPPaaaannnneeee

The Control Pane in the Assignment window contains 16 pairs of popup menus, in which MIDI inputs
or LiSa’s internal modulators can be assigned to various Parameters.  Assigning MIDI inputs to either
effects Parameters or sample region Parameters involves the same process, all of which is done in
the Assignment window:

Selecting the Voice Layer in the Zone Assignment pane (see Assigning Controllers to Parameters
below).

Selecting a Parameter to be controlled in the Parameter Control pane.

Assigning Controllers from the Controller Library to sample region or effects Parameters in the
Parameter Control pane.

Creating and assigning CTabs, if desired, to the various Parameters. CTabs affect individual Zones,
and not the overall input of a controller, so different Zones in the same Voice Layer can
respond differently to the same controller.  CTabs are set in the Zone Editor of each
individual Zone.

Voice Layers and MIDI Channels

Each of the radio buttons on the top of the
Assignment window is actually a popup menu, which
can be set to any number from 1 to 16.  This number
sets the MIDI channel number the Voice Layer
listens to.  It is possible to have any number of Voice
Layers assigned to a single MIDI Channel.  This has
two main consequences:

� You can activate more than one Zone from a
single key.  This is done by assigning the Zones to
the same key in different Voice Layers responding to
the same MIDI channel.

� Controllers can affect more than one Voice
Layer.  By assigning a Controller to a MIDI Channel
that affects more than one Voice Layer, one
Controller can affect parameters in multiple Voice
Layers.

If nothing is selected in the Assignment Window, selecting Copy from the Edit menu will copy the
entire Voice Layer to the clipboard, from where you can paste it into another Voice layer in the same,
or another, Preset.
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Assigning Controllers to Parameters

The Parameter Control pane of the Assignment Window can be thought of as the patchbay where
you can connect Parameters to Controllers (either external MIDI or the internal modulators -- see
below).  The pane is comprised of 16 pairs of popup menus.  There are two ways to assign a
Parameter to a Controller:

� Click on the left-hand menu.  This is the Parameter Select menu.  A popup menu of all
Parameters will appear.  Select the Parameter you want to control.  From the right-hand
menu, the Controller Select menu, select a Controller, or create a new one.

� Drag Parameters and Controllers from their respective Libraries to the appropriate menu
spots in the Parameter Control pane.

A Parameter must always be selected before a Controller.  A Controller Select menu will not respond
unless it has a Parameter assigned to it.  A Parameter may only be connected to one Controller per
Voice Layer.  Used Parameters will be grayed out in the Parameter Select menu, and bulleted in the
Parameter Library.

PPPPaaaarrrraaaammmmeeeetttteeeerrrrssss    aaaannnndddd    CCCCoooonnnnttttrrrroooolllllllleeeerrrrssss

Parameter Library

The Parameter Library is fixed – you can use it to drag Parameters to the Assignment window, and as
a reference to see which Parameters have been assigned to the current Voice Layer.  Assigned
Parameters are marked with a bullet in the Parameter Library window.  A Parameter may only be
assigned once in a given Voice Layer.  Unlike other Libraries, the bulleted Parameters indicate which
are used in each Voice Layer, not each Setup.

Controller Library

The Control Library will always appear at first
with a limited set of the standard MIDI controls.
Any Controllers you create in the Controller
Editor will appear here.

You can add your own custom controls, which
may be either MIDI inputs or modulators, to the
Controller Library.  You can drag Controllers
into the Assignment Window, or access them
from the popup menus in the Control pane.

Creating Controllers

Controllers may be created from either the Controller Library or the Parameter Control pane of the
Assignment window.  The Control Editor window will automatically open when you create a new
Controller.

� To create a new Controller from the Library: click on New.

� To create a new Controller from the Assignment Window, select New Controller… from one
of the Controller Select menus in the Parameter Control pane.

Once you have created a new Controller, the Controller Editor will automatically appear, and it will be
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available for editing.

Editing Controllers

At the top of the Controller Editor are numericals for the number and name of the Controller.  Like
Zone numbers, these are for internal reference only and may not be changed.  Scrolling through the
controller number numerical will bring up the appropriate Controllers in the Controller Library for
editing. You can also scroll through available Controllers in the Controller Editor using the left and
right arrow keys.   The second numerical is a name field, which can be edited the same way as Zone
names.  The two radio buttons select between external MIDI control and internal modulators.

MIDI Controllers

� 

Clicking on the Type numerical will bring up the
MIDI Controller Menu.  This shows the MIDI input
options available.  The Controller item has a
submenu showing all 128 MIDI controller
numbers.  Select the menu item, rename the
Controller, and you’re done.  If your MIDI is
plugged in, it is also possible to select your MIDI
input by selecting the Type numerical and
activating the controller you want to use.  LiSa will
automatically detect which controller you are using
and show it in the numerical.  This works for all
MIDI except note number and velocity.  (Hitting a
key will enter Aftertouch or Poly Key Pressure,
depending on which your keyboard is using)

Channel and Voice MIDI Control

There are two different types of MIDI input in LiSa: Those that affect the entire Voice Layer, and those
that only act on the current sounding voice.  Poly Key Pressure, Note Number, and Note Velocity will
affect every voice separately – if Note Velocity, for example, is connected to Tun, the pitch of each
voice will depend on the velocity of the key that activated it.  The other Controllers, including Last
Note Number, and Last Velocity, will affect all active Zones in the Voice Layer.  If Last Velocity is
connected to Tun, all active Zones will change their pitch when a new note is struck.  Likewise with
panning – A Channel Controller will move all voices on that Voice layer to the new panning position.
(This can be varied from Zone to Zone with CTabs, of course)  All of LiSa’s internal modulators are
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Voice Controllers.

Modulators

In addition to external MIDI, you can create any number of internal modulators to control Parameters.
These work by automatically reading tables at a preset speed. As we will see below, this speed can
itself be varied with another controller.  LiSa has some tables built in, but it is also possible for the
modulators to read from custom tables. To create a modulator:

� Select the Modulator radio button.

� Select a table from the Shape menu

Shape.  This popup menu determines the wave shape of the modulator.  There are
four permanent tables built into LiSa, with sine, sawtooth, and square waves,
and one random table.  The default is a table, with Table Nr. 1 as the
selected table.  To use a custom table, select Table from this menu, and
select the table you wish to use from the CTab menu to the right.

CTab.  If you have selected Table from the Shape menu, this menu will become
available.  You can select a table from ones you have already created, or
make a new one by selecting New Table… from the menu, which will open
up the Table Editor.

Table Select.  These two menus allow you to control the table that the modulator is
reading.  You can select the controller which will select tables in the
Controller menu.  In the CTab menu, you can pick a CTab to filter the
controller.  (For more on table selection, see Table Editing Parameters, p.
93).  This is a particularly powerful feature that allows you to change the
table the modulator reads in real time.

Speed.  Sets the speed at which the modulator will be read.  The maximum and
minimum speeds will vary depending on the size of the table.  Range is from
0.01 to 127.0.  Note that these are floating point values.   Maximum
modulator speed is dependent on the Signal Vector size of your setup. (For
more on this see Appendix 1.) You can also set a controller to vary the speed
in the Controller menu. The range of the controller can be set with the
selected CTab in the menu to the right.  To remove the modulator’s speed
control, select Remove from the popup menu.

CCCCoooonnnnttttrrrroooolllllllleeeerrrr    BBBBeeeehhhhaaaavvvviiiioooorrrrssss
As mentioned above, controllers are assigned to parameters in the Parameter Control Pane of the
Assignment window.  Clicking on one of the left-hand small boxes presents a pop-up menu with all of
the parameters listed below.

Some Zone Parameters behave slightly differently under MIDI control than when they are changed by
hand in the Zone Edit window.  All Controller behaviors are described in detail below.  Note that
‘Controller’ here means any kind of input that can be assigned in the Parameter Control pane of the
Assignment window; i.e., velocity, pitchbend, etc. plus internal modulators.

For Parameters that only refer to specific Zone functions or modes, Controllers will only affect Zones
of the appropriate type; e.g. changing the Spiralness Parameter will only affect Playback Zones in
Spiral mode.

Also keep in mind that although MIDI control is assigned to an entire Voice Layer, individual Zone
responses will depend on what (if any) CTab is assigned to the individual Zone’s MIDI input and the
settings in the Region pane of the Zone Editor window.



LiSa v. 2.5 manual, p. 89

Sample movement parameters

Nothing.  No Parameter is available, and no Controllers may be assigned in the corresponding
Controller Select menu.

Absolute Region Start.  This Parameter controls
the start position of the sample region of
the Zone.  This Parameter is always
additive, e.g., the higher the value, the
further ahead of the original sample region
start point (as set in Stt in the Zone Editor)
the start of the sample region will move.
The maximum range covered by this
Parameter will depend on the size of the
Mvr (movement range) numerical.  The
CTab connected to the Abs. Start value is
the one to the right of the Mvr numerical in
the Region pane of the Zone editor. If you
set your Mvr high enough to move your
sample region out of the buffer, LiSa will
loop the region around back to the
beginning of the buffer

When controlling Sample
movement from a controller,

and jumping the sample
pointer around, you can

reduce the amount of
clicking by increasing the

Crossfade parameter in the
LiSa Settings Dialog.  Keep

in mind, though, that the
longer the crossfade, the

more stress on your CPU.

Relative Region Start.  If the Mvr of a sample is
very large, it is possible that the jumps
between Controller values will skip more
samples than you would like.  Rel. Start
acts as a fine tuner for your sample region
start point. The overall range of Rel Start
is set in the Global LiSa Settings window,
expressed as a percentage of the Mvr
parameter of the Zone in question.  For
example, if the Rel. Start range is set to
10% (default), and the Mvr of the zone is
12 seconds, the control range 0-127 will
move the start pointer from 0.0 seconds to
1.2 seconds.  It is not necessary to have
Abs. Start enabled for Rel. Start to work.
The CTab connected to the Rel. Start
value is the one to the right of the St t
numerical in the Region pane of the Zone
editor.

Region SP Offset.  To those of you familiar with
earlier versions of LiSa, this control
parameter replaces the region/pointer option
switch.  When a controller is sent to this
Parameter, it moves the sample pointer itself
within the sample region.  The Zone’s region
does not change, and the Mvr Parameter
has no effect.  Every time your Controller
moves the pointer, the sample will start to
play again from that point, and will continue
to the end.  Once it reaches the end of the
sample, it will either loop or stop, depending
on the Advance mode of the Zone.

Region Length.  This Parameter changes your total
sample region length in relation to the
original length set in Len in the Zone Editor.
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A control value of 0 will shrink the sample
region to 1.5% of its original length, and a
control value of 127 will double it.

Zone Reset.  When this is sent a 0, and only a 0, all
Zones on the channel, active or not, will
automatically revert to their original settings
as described in the Zone editor.  This
includes start and length of the sample
region and effects settings.

Output Parameters

Output Level.  Sets output level for playback Zones in all modes.  Equivalent to the Lev numerical in
the Zone Editor.

Panning.  Controls the pan position of a Zone.  0
= 100% right, 127 = 100% left. The exact
behavior of this input depends upon
whether the MIDI control is a voice or
channel control. (See Channel and Voice
MIDI Control, p. 87.)  If it is voice-specific,
pan for each instance of a Zone will vary
depending on its MIDI control.  If channel-
specific, all voices in the Voice Layer will
move together.

T u n i n g .  Works the same way as the T u n
numerical found in all Playback Zones.
You can set the range of pitch change in
the Pitch Bend Range...  dialog in the
Global menu.

Fuzz.  Amplifies previously recorded sample.
Works exactly the same way as the Fuz
numerical in the Playback Treatment pane
of the Zone Editor.

You can get different
Envelopes (or patterns) in

different Zones by giving each
Zone a different CTab for this

variable.

Envelope Select.  Sending a Controller value to
this Parameter will change the envelopes
in all Zones in the Voice Layer to the
envelope of the corresponding number in
the Envelope Library.  This index works
like program change messages, i.e. the
Controller value will always be one less
than the index number of the envelope.
Control value 0 brings up envelope 1, etc.
To avoid changing all envelopes in a layer
identically, use CTabs or voice-specific
Controllers with this Parameter.
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Pattern Controls

� 

Pattern Select.  Sending a Controller value to
this Parameter will change the pattern in
all pattern Zones in the Voice Layer to the
pattern of the same number in the Pattern
Library.  If you have 10 patterns, control
value 0 or 1 will load pattern number 1, 2
will load pattern 2, etc.  Note that this is
different from how Tables and Envelopes
are selected.  To avoid changing all
patterns in a layer identically, use CTabs
or voice-specific Controllers with this
Parameter.

In Pattern Select and Envelope Select,
sending control values that do not have a

pattern or envelope connected to them
will automatically select the highest-

numbered pattern or envelope.  Thus if
you have less than 128 patterns or
envelopes, a CTab is more or less

required to map your various patterns
across your control range

Pattern Parameters 1-4.  These are assigned
to different aspects of a Pattern Zone.
The operation of these Controllers is
discussed in full in Pattern Modes, p. 64.

Playback Zone Parameters

These items control depth or degree of output effect on Playback Zones in various modes.  Full
control range covers the full range of the Parameter, (scaled to seven bits of resolution) however its
range is expressed numerically in the Zone Editor.

Spiralness.  Changes the mystery Parameter
(Spl) for Zones in Spiral mode.

Playback Direction.  This control only works for
Playback Zones in Back and Forth mode.
Any control value below 64 will force the
playback pointer to a forward direction, no
matter what direction the Zone was
originally playing in.  At 64 or above it will
force the playback pointer to move
backwards until it reaches the start of the
region.

Resonance Frequency and Resonance Depth.
Controls these two values for Zones in Resonator
mode (Res and Dpt).

Scrub.  Changing this control value ‘scrubs’ the
sample backwards and forwards.  Due to
the design of this mode, pitchbend is the
most suitable controller.  As you increase
the values above 64, you will hear the
sample looping in a forward direction,
increasing in pitch as the control value
goes up.  As you go below 64, the same
thing will happen, except the sample will
go backwards.  At a value of 72 (forwards)
or 56 (backwards) the sample plays at its
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original pitch.

Record Parameters

The next five MIDI inputs control record Parameters, and function exactly as they do in the Zone
Editor for Record Zones.  For details see Recording a Sample, on p. 68.

Input Level.  Controls the input level of sounds
as they are recorded.  Identical to the Inp
numerical in the Record Treatment pane.

Feedback.  Controls the amount of old sound that
is retained when loop recording.  Identical
to the Fdb  numerical in the Record
Treatment pane of the Zone Editor.

New in v. 2.5: Overdrive in playback

Remember, when using this
parameter for recording, that it

will affect Playback Zones in
the same voice layer, so it

might be wise to keep your
Playback and Record Zones

on separate Voice Layers.

Overdrive .  Overdrive is an extension of the
feedback control -- rather than attenuating
the previous signal, it amplifies it.  You
can think of it as Feedback values of more
than 100%.  In order for O v d to take
effect, set Fdb  to 100.  Identical to the
Ovd numerical in the Record Treatment
pane of the Zone Editor.  In addition, the
Ovd parameter now has an effect on
voices while playing back.  Increasing this
parameter while there are voices playing
back will create a DC offset in the sound,
creating a rather interesting distortion
effect, which is guaranteed to drive
soundmen mad at all your gigs.

Erase.  This Parameter is most useful when using
LiSa as a delay system.  Increasing this
value when loop-recording sound will
decrease the amplitude of whatever you
record into the Sample Buffer at that time,
and a value of 127 will erase it entirely.
This can be very useful for ‘punching
holes’ in repeatedly delayed material.  The
Erase function cannot be connected to a
CTab.

Threshold.  Identical to the TOn numerical in the
Region pane of the Zone Editor.  Sets volume
threshold for recording.

Filter Parameters

Filter Frequency.  This controls the frequency
(high cutoff, low cutoff, or bandwidth
center, depending on the filter)of the filters
used in Playback Zones.  0 is lowest, 127
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highest.

Filter Q. Sets the q (steepness of the filter slope)
of the filter.  0 is flattest, 127 steepest.

Table Editing Parameters

For changing table values in real time.  See Real-time Control of Tables on p. 94 for details.  Note
that it is not possible to connect a CTab to any of these Parameters.

Edit Table Select.  This is an indexing
Parameter, like Envelope select.  The
Controller value will select the number of
the table edited by the other three MIDI
controls.  Since CTabs cannot be used,
you can only access the first 128 tables
for real-time editing.

Selected Table Index.  Midi values sent here will
set the index number (X value) of the
table to be altered by Selected Table
Value.

Selected Table Value.  Sets the Y value of the
index selected above.

Selected Table Length.  Changing this
parameter will vary the amount of the
table that is actually looked at.  The
control range (0-127) is automatically
scaled to the size of the table.

Wave Table Parameter

Used in Wavetable Playback Zones.

Wave Table Mix.  Controls the relative volume of
the Source and Destination waveshapes.  0 is
100% Source, 127 is 100% destination.

MMMMaaaappppppppiiiinnnngggg    MMMMIIIIDDDDIIII    CCCCoooonnnnttttrrrroooolllllllleeeerrrrssss    ––––    CCCCTTTTaaaabbbbssss
Tables (CTabs) can be used to map linear Controller signals to other sets of values.  For a general
description of creating and editing tables, see Tables and Envelopes, p. 46.

Controllers
Although MIDI input effects all enabled Zones
assigned to that Control Layer, the response of
each Zone to that MIDI input does not have to be
identical.  You can map the input to any output
you desire with CTabs.  To the right of all the
MIDI-controllable Parameters in the Zone Editor is
a numerical labeled CTab.  Clicking on this will
reveal a popup menu with all available CTabs.
From here you can choose the Control Table to
which incoming MIDI is mapped.
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MIDI input is mapped to the X value, and MIDI
output to the Y value of the CTab.  Tables of any
size can be used – LiSa will interpolate the values
to the 0-127 of MIDI controllers.

Indexes

If you want a Zone to respond to some
MIDI inputs but not to others, linking a

parameter to a CTab that contains one
fixed value (for example, 64 for the

tuning parameter) will effectively disable
it.

Some Zone Editor Parameters (notably envelope
select and the pattern modes) use MIDI
controllers to select between options rather than
control variables.  CTabs also come in handy for
this – you can map out the full range of a
Controller to select all or a selection of items out
of the Envelope or Pattern Libraries.  It is often
handy to use MIDI notes rather than a continuous
controller to choose between index numbers.  This
can be done using MIDI Processors, which can
convert note information to controller information.
See p. 98 for more on this.

Real-time Control of Tables

You can use MIDI to change table values in real time.  Tables being used for any purpose can be
changed, although it is most powerful when used to change tables being read as waveforms.  To do
this requires at least two control sources.  Settings for real-time control of tables are made in the
Control pane of the Assignment window.  To edit a table via MIDI:

Edit Table Select.  If the Parameter is connected
to a Controller, that Controller’s value +1
will select the table number to be edited.
(It works like Program Change messages
– an index value of 0 will edit table 1, etc.)
If no Controller or modulator is connected
to this Parameter, all MIDI sent to the
other Table Edit Parameters will
automatically be applied to table number
1.  Note that there is no way to control this
Parameter with a CTab, so you may have
to think carefully about what order and
where those tables are in your Table
Library.  In addition, this means that only
the first 127 tables in your Table Library
can be edited in this manner.

Selected Table Index.  The value this
Parameter receives will set the index
number (X value) of the table to be edited.
If it receives a value of 16, whatever value
comes into the Selected Table Value
Parameter will change index number 16.
This Parameter by itself changes nothing
in the table.  It is often useful to connect a
modulator attached to a sawtooth wave
the same size as the table to be edited to
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this Parameter, to be able to change
values sequentially.

Selected Table Value.  Sending a value to this
Parameter will immediately change the
value (Y value) of the table at the index
specified in Selected Table Index.

MMMMiiiisssscccceeeellllllllaaaannnneeeeoooouuuussss    MMMMIIIIDDDDIIII    CCCCoooonnnnttttrrrroooollllssss

Sustain and Sostenuto

LiSa also supports MIDI Sustain and Sostenuto commands, both directly from the Status window and
via MIDI.  Enabling Sustain on a MIDI channel will keep all Record or Playback Zones in the effected
Voice Layers active until Sustain is turned off for that channel, at which point all sustained notes
receive note off messages.  Enabling Sostenuto acts like sustain as long as it is on.  When Sostenuto
is turned off, all held notes will continue to hold until the key that activated them is pressed again.

Each of the 16 buttons next to the words Sustain and Sostenuto will enable sustain or sostenuto on
Voice Layers 1-16.  Clicking with the cursor in these buttons will toggle them on and off.  If more than
one Voice Layer is assigned to a particular MIDI Channel, enabling Sustain for that Layer will enable
it for all other Layers sharing that MIDI Channel as well.

You can also activate Sustain and Sostenuto from MIDI messages:

� A value of 127 from Controller No. 64 will turn on sustain for all Voice Layers connected to
that MIDI Channel, and a value of 0 will turn it off.

� A value of 127 from Controller No. 66 will turn on sostenuto for all Voice Layers connected to
that MIDI Channel, and a value of 0 will turn it off.

Sustain and sostenuto can be enabled from the keyboard for the active Voice Layer.  ‘+’ will toggle
sustain on and off, and ‘-’ will do likewise for sostenuto.

Velocity Mapping
It is important to note that velocity is always
connected to the amplitude of a Zone in the
traditional MIDI manner – the harder you hit, the
louder the sound is, reaching the volume set in the
Lev numerical when a key is struck with a velocity
of 127.

It is possible to change the relationship between velocity and volume response by using a CTab,
however.  If you look at the Play Treatment pane in the Zone Editor, pressing Shift will turn the value
of the Lev numerical into the word Vel.  The CTab to the right of the numerical is connected to
velocity.  By adding a new table here, you can change the relationship between velocity and volume.
In the example, a table titled Inverse, which goes from 127 to 0 has been inserted, so a soft touch will
be loud, and a loud one soft.
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Amplify Current Zone

It is possible that you will record a sound at a
level that is unsuitably low in volume when
played back.  It is possible to amplify the
sample region of your current Zone (that is,
the last Zone played, or the one visible when
you have Show Current Zone selected) by
sending it a MIDI control value.  This is set
from the LiSa Settings... menu item in the
Global menu.  (See p. 16.)

In Amplify Current Zone, there are two variables.  The first is the controller number.  Sending any
value on this Controller on any channel will cause the sample region of the selected Zone to be
amplified by the percentage specified in the numerical labeled %Gain.  (This works best with a
controller you can send from a button rather than a slider -- every time you change the slider value,
you will ‘bump up’ the amplitude of the signal.)  This numerical has a range of 0 - 200% amplitude of
the original signal.

Using this will permanently change the sound in the Sample Buffer, although not in your original
soundfile, if the sample comes from one.  Repeated amplifying will cause distortion akin to analog
distortion, not digital clipping.  It also is slightly slower than real-time.  If your region is fairly short, it is
fast enough to use in performance, but not instantaneous.  The speed of your computer will also
affect this -- it’s best to experiment a bit before trying it out on stage.

Clear Sample Buffer

You can now clear the entire sample buffer of
sounds via external MIDI control.  In the LiSa
Settings dialog box, you can set a controller
(which operates on the System Channel), which
will clear the Sample Buffer when you send it a
value of 0.

Envelope Followers

The audio input into LiSa can be converted to
MIDI.  Audio can generate note on and off
messages, and be attached to MIDI controllers.
LiSa uses the amplitude of the incoming signal to
generate these MIDI values.  Settings for the
Envelope Followers are made in the LiSa
Settings item in the Global menu.  This MIDI is
treated exactly as MIDI coming from an external
device.  Settings can be different for Left and
Right inputs.

EF Channel.  All MIDI from the Envelope
Followers is sent on the channel set here.

Note that these settings
have nothing to do with

recording audio as it
comes in.  These settings

are only for MIDI.

EF Note Nr.  When the Envelope Follower detects
input above the threshold level, it will send
a note on message to LiSa for this value
on the MIDI channel specified above.
When the signal goes below the
threshold, it will send a note off.

EF Threshold.  Here you can set the threshold
level for note on and off messages.
Amplitude above the threshold will
generate a note on, and when it falls
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below the threshold, a note off.  Setting
this numerical to zero will cause a note on
when any audio is received, and at 127
the envelopes will never be triggered.

EF contr. Nr.  Here you set the Controller number
for the Envelope Follower.

Enable/Disable.  This numerical controls the
functionality of the Envelope Followers.

To use MIDI from the envelope followers, treat it like any other MIDI input:

For Note on messages, just drag a Zone to the
key specified, and it will be activated once
the EF passes the threshold.

For Controllers, create a new Controller in the
Controller Library with the number of the
MIDI controller you have assigned in the
dialog box, and treat it as any other
external Controller.

Pitch Trackers

New In v. 2.5: Pitch
Trackers

LiSa now has the ability to take pitch information
from audio inputs and convert it to MIDI.  It works
in a way similar to the Envelope Followers.     LiSa
listens to incoming audio, attempts to isolate a
dominant pitch, and converts this information to
MIDI.   When using this feature, there are two
things to keep in mind:

� The accuracy of the pitch tracking will
be very dependent on the kind of input
it is receiving.  The noisier a signal, the
less accurate the pitch tracking will be.

� Using the pitch trackers is very
processor-intensive, and when using
them you will have fewer voices
available.

The pitch tracker takes the pitch input, and scales it to a range of 0-127.  The MIDI output range is
scaled to the values between the Frq Min and Frq Max. For example, if the Frq Min parameter is set
to 110 Hz, and the Frq Max is set to 1760 Hz (four octaves), the pitch tracker will output a 0 when it
hears a pitch of 110, 32 at 220 Hz, 64 at 440 Hz, etc.

The pitch tracker can be set to output controllers 0-127, pitch bend, channel aftertouch, program
change, or MIDI notes.  When you choose MIDI notes as the output, a note is turned on as soon as
the input enters the active pitch range.  When the input pitch changes, the old note will be turned off,
and a new note will be immediately initiated.  Thus there will always be some note on as long as the
input sound is within the active pitch range.

Settings for the pitch trackers are found in the LiSa Settings dialog in the Global menu.

Channel.  The MIDI channel on which Pitch Trackers send MIDI
data.

Event.  Here you can choose what kind of MIDI event the Pitch
Trackers will generate.
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Frq. Min.  The lowest frequency to which the Pitch Tracker will
respond.

Frq. Max.  The highest frequency to which the Pitch Tracker will
respond.

Enable/Disable.  This numerical controls the functionality of the
Pitch Trackers.

MMMMIIIIDDDDIIII    PPPPrrrroooocccceeeessssssssiiiinnnngggg
The MIDI Process Editor is a very powerful tool which adds an extra level of specialized control to
your MIDI input.  The Process Editor can be thought of as a way of mapping one type of MIDI input to
another: Aftertouch can be used as note ons, MIDI notes can be used to increment and decrement
controllers, and so on.  This can be particularly useful if you have a limited number of hardware
controllers – you can assign as many keys on your keyboard as you would like to function as MIDI
controllers.

Architecture

MIDI Processors function in LiSa much as any other element does: You create processors in an
editor, and can store as many as you wish in a Library.  Each Processor is designed to handle one
particular input as it comes into LiSa.  A Processor is associated with a Setup, so all Voice Layers
and Presets within a Setup are affected.

The MIDI Process Library

This functions as any other library does in LiSa:
You create new Processors here, by clicking on
the New button, and can save, import, or export
the Library just like any other.  Unlike many of
LiSa’s other functions, you can only create new
Processors in the Library.  Active Processors are
marked with a bullet.
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The MIDI Process Editor

The two topmost numericals, like in
all editors, contain the number of the
Processor being edited, and the
name of the Processor.  You can
scroll through the Nr. numerical to
switch between Processors, and
change the name in the N a m e
numerical.

The Act ive  radio button in the
topmost pane simply turns the
Processor on and off.  If a
Processor is deactivated, the MIDI
that would otherwise be treated
simply passes into LiSa unchanged.
The only place where Processors
can be activated or deactivated is
here in the Editor.

The two lower panes are where you actually change the settings for your MIDI input.  Each of these
panes is for a different type of input:  The upper is for MIDI note inputs, and the lower is for all others.
A single Processor can only process one kind of MIDI input at a time.

The Note Pane

When the Note radio button is selected, you set your processing in this pane.  Note on messages are
transformed into continuous inputs (controller, aftertouch, pitch bend, or program change).  It works
by selecting two input notes, assigning one to increment and one to decrement the selected value.
The numericals to the left of the arrows indicate the input, and to the right, the MIDI input as LiSa will
see it.

Chan.  The leftmost of these two numericals sets the
channel for the incoming notes to be processed, and
the rightmost sets the channel as it comes in to LiSa.

Note Incrementor/Decrementor.  These two notes,
when played on your MIDI keyboard, will
either raise or lower the value selected in the
Event Type numerical by one each time the
note is played.  Note Off messages are
ignored.

Event Type.  You select the output (controller,
aftertouch, pitch bend, program change, or poly key
pressure), in this menu.  If you choose PolyPres
(polyphonic key pressure) a numerical will appear
beneath this menu where you can choose the note
that the pressure message will be sent to.

Event Data Table.  This is a CTab for the output of
the Processor.  If you wish to map your input values
to a different set of values, you can do it by making a
custom table to map your input, and selecting it in this
numerical.  Incrementing or decrementing will then
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step through the values in the table.

In addition to these basic setup controls, there are two additional options for note inputs:

Polypres. If your keyboard has poly key pressure,
holding down your incrementor or
decrementor keys will cause the event to
continually increment or decrement as long
as you keep generating pressure.  The
incrementor key will increase the value as
you apply pressure, and the decrementor the
opposite.  One of the advantages of this
system is that unlike poly key pressure used
directly, releasing the key will not return your
value to zero.

Wrap.  When this is selected, incrementing the
controller value over 127 will automatically
wrap the output value to zero, and vice versa.
If this is not checked, once a control output
reaches its minimum or maximum value, it
will remain where it is, regardless of whether
the increment/decrement note is played.  If
Polypres is selected, this option is disabled.

Other

Selecting this radio button configures the Process Editor to receive controller, aftertouch, pitch bend,
or program change data, which can be used to trigger note events.  When the incoming data goes
above a certain threshold, a note on will be triggered on a selected note.  The note will be turned off
when the input goes below the threshold.

Chan.  The leftmost of these two numericals sets the
channel for the incoming data to be
processed, and the rightmost sets the
channel as it comes in to LiSa.

Event Type.  This selects the input that the
Processor will look at on the selected MIDI
channel.

Note.  This is the note that LiSa will receive, on the
output MIDI channel selected above in Chan.

Threshold.  When the incoming MIDI exceeds the
value specified in this numerical, the note
selected is triggered.  The velocity is equal to
the input value.  For example, if your Event
Type is program change, the Note numerical
is set at 60, and the threshold is 50, program
change 100 will produce a note with a
velocity of 100. If you are using an input that
generates continuous data, however your
velocity will almost always be threshold plus
one, since as soon as the threshold is
passed, the note is generated.

Thru.  When this box is checked, any MIDI input
values are transmitted to LiSa, as well as
triggering the note event.  If it is not checked,
the controller information is ignored.
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CCCCoooonnnnttttrrrroooolllllllliiiinnnngggg    LLLLiiiiSSSSaaaa    ffffrrrroooommmm    tttthhhheeee    CCCCoooommmmppppuuuutttteeeerrrr
When editing a Setup, it is sometimes convenient to be able to test it without having to use an
external MIDI device.  This can be done in two ways: Notes can be activated directly from the
computer keyboard, or you can use the Mouse Control window. LiSa treats all MIDI coming from the
keyboard or Mouse Control window just as any other MIDI coming from an outside source – CTabs
and MIDI Processors remain in effect.

Playing Notes from the keyboard

Setup

In the Global menu is the item Keyboard MIDI Map…  Selecting this will present a window with a
set of numericals, three for each of the alphabetical keys of the keyboard.

Using these numericals, you can set a channel value, note number, and velocity for the alphabetical
keys.  The note assignments are saved with your Setup.

New in v. 2.5:  Toggle and
repeat keyboard options

There are two new checkboxes next to each key,
which give you additional flexibility when using the
keyboard for note input:

Keyboard Toggle. When this checkbox is selected,
the note played will remain on until the note is
pressed again.  Default is on.

Keyboard Repeat.  When selected, a key held down
will repeat at the normal keyboard repeat
rate.  When typing normally, a key will simply
start repeating if it is held down for a certain
period of time.  When this option is selected
for a key, pressing it will refire the note at the
repeat rate.  The most useful application for
this option is to use your computer keyboard
as a continuous controller.  Using the MIDI
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Processor discussed above, you can convert
the repeated note events into increments or
decrements of a controller, so you can
change a control value from the keyboard
simply by holding a key down rather than
tapping it repeatedly.  (The rate of keyboard
repeating depends on your system, and can
be changed in the Keyboard control panel)

Behavior

To activate computer keyboard MIDI, press the Caps Lock key.  This will toggle keyboard MIDI on.
Pressing Caps Lock again will deactivate it.  The number of notes you can play from the keyboard at
a time varies from computer to computer.  You can, of course, enable Sustain for the MIDI Channel
you are using.  Both Sustain and Sostenuto work normally.

The Mouse Control Window

The Mouse Control Window, available from the Windows menu, allows you to use the mouse in
place of external MIDI input, for testing or performance purposes.  It has been significantly improved
in LiSa 2.5, with up to 18 possible controllers, including poly key pressure.  X-Y type mouse
movements are no longer possible through this window, but an improved version of this functionality
has been moved to the MIDI Snapshot function, described in MIDI S on p. 104.  All Mouse control
assignments are saved per Preset, so it is possible to have a different set of mouse controls for each.
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Playing Notes

The main pane of the Mouse Control Window is an elongated representation of the current Voice
Layer keyboard.  Clicking in this area of the window will activate the note.  The higher up in the
window you click, the greater the velocity.  The note will remain on as long as the mouse button is
held down.  Click-dragging will play notes as you move the mouse around.  The most recent note
played is displayed at the bottom of the main pane.  Sustain and Sostenuto for the current Voice
Layer can be activated using the buttons at the top of the window.

Using Controllers

Each of the 18 sliders under the main pane can be assigned to a controller, aftertouch, pitch bend, or
poly key pressure.  These are assigned using the three numericals at the top of the window.

� To choose the slider you wish to assign to a controller, select the slider number in the
leftmost of the three numericals at the top of the window, move the slider you wish to use with
the mouse, or click on the number below the slider.  The number of the selected slider will be
highlighted in red.

� In the center numerical, you can choose the controller you want the selected slider to output.
This will behave exactly like MIDI control coming from an outside source.

� If you have chosen poly key pressure, the rightmost numerical will become available.  Here is
where you can choose the note that the poly key pressure will be controlling.

Once you have configured this window, you can move the sliders with the mouse to send control
information to LiSa’s MIDI input.  Click-dragging a slider will move it.  To adjust several sliders at
once, shift-drag in the slider area.
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MMMMIIIIDDDDIIII    SSSSnnnnaaaappppsssshhhhoooottttssss

MIDI snapshots are one of Lisa’s most powerful new features.  With Snapshots, you can record the
entire MIDI state of your setup, and either switch between these states or interpolate between them
using your mouse or MIDI.  This makes it possible to control a large number of variables with only a
single control.  You can design a whole piece around a series of snapshots, switching and
interpolating from one to the next.  Snapshots can be very simple to use, but it is also possible to do
extremely complicated things, such as creating a score of a piece, using Snapshots.

QQQQuuuuiiiicccckkkk    SSSSnnnnaaaappppsssshhhhooootttt    CCCCrrrreeeeaaaattttiiiioooonnnn
The operation of snapshots can be most clearly explained if you have actually created a couple.  For
a start, we will create two snapshots which use only controllers, to give us some material to work
with:

� Open the Snapshot Control Window and
the Mouse Control Window.  The sliders
(which default to controllers 1-18) will be used
to provide a handy example.

� Move a couple of the sliders around with
the mouse.  You have now changed the MIDI
state of LiSa.

� In the Snapshot Control Window, there
are four popup menus, all of which now have
the name of the default snapshot, ‘Empty
Snapshot’.  Pull down one of these menus
and select New Snapshot.  A new Snapshot
will be created with the name ‘Control
Snapshot 2’.  This contains the current values
of the controllers you have changed in the
Mouse Control Window.

� Move the sliders in the Mouse Control
Window to new positions, and do the same in
one of the other popup menus. Control
Snapshot 3 will be created.

� In the Snapshot Control Window, click-
drag the mouse between the two corners with
the new snapshots in them, and you can see
the sliders in the Mouse Control Window
interpolating between the states set in the
Snapshots you have created.  If you move the
cursor towards one of the corners labeled
‘Empty Snapshot’, all the sliders will go
towards zero.

You now have two different Snapshots, each being a record of the entire MIDI state of LiSa at the
moment you created them.  Although we have only used controllers in this example, any MIDI
message can be included.  Note ons and program changes are handled slightly differently from
continuous controls – that will be discussed below.  Now that we have some data to work with, let’s
take a closer look.
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AAAArrrrcccchhhhiiiitttteeeeccccttttuuuurrrreeee
Snapshots are used in sets of 4, called Snap Sets.  Each Setup can hold 128 Snap Sets.  They are
stored on the Setup level, so whatever Preset you are in, you will have the same set of Snapshots
available.  A Snap Set represents 4 different MIDI states that you can interpolate between at any
one time.  You can change between Snap Sets by sending Program Change messages on the Meta
Control Channel (see LiSa Settings, p. 16) Snapshots are handled via three windows:

� The Snapshot Library, which works as all the libraries in LiSa.

� The Snapshot Editor, where you can set and fine-tune the contents of individual
Snapshots.

� The Snapshot Control Window.  This is where you create and select your snapshot sets
and interpolate between them with the mouse.

TTTThhhheeee    SSSSnnnnaaaappppsssshhhhooootttt    lllliiiibbbbrrrraaaarrrryyyy
If you take a look at the Snapshot Library, you will see three items: the two snapshots you have just
created, plus the default, called Empty Snapshot.  We suggest that you always leave this one as it
is, for reasons that will become clear below.  As with all Libraries, clicking on the New button will
create a new Snapshot. Snapshots that are assigned to a Snap Set are bulleted.

When creating a new Snapshot in the
Snapshot Library, it will not be empty.  It
will reflect the current MIDI state of LiSa

at the moment you have created the
snapshot.
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TTTThhhheeee    SSSSnnnnaaaappppsssshhhhooootttt    EEEEddddiiiittttoooorrrr

The Snapshot Editor contains a list of the entire
MIDI status of LiSa at the time the snapshot
was made.  At the top of the window are the by-
now familiar Num and Name numericals, and
below, the MIDI Event List, describing the MIDI
state of the Snapshot.  It is possible to edit MIDI
settings by hand, adding, removing, or changing
any MIDI setting of the snapshot.  It is divided
into 4 columns.  Each entry is a numerical – to
select an entry, click once.  To edit it, double-
click.

The first column, Chan., sets the MIDI channel
for the event.  The next column, Type, is where
you see the kind of MIDI event it is.  The next
two columns, Data 1 and Data 2, will mean
different things depending on the type of MIDI
event it is.

Below is a list of the MIDI event type, its abbreviation in the Type column, and what the Data
columns signify:

MIDI Event Abbreviation Data 1 Function Data 2 Function

Note On NON Note number Velocity

Poly Key Pressure PKP Note number Pressure amount

Controller CTR Controller number Controller value

Program Change PCH -- Program number

Channel Pressure (Aftertouch) PRS -- Aftertouch

Pitchbend PBD 64 (fixed) Pitch bend value

Any of the events that are already listed in a snapshot may be edited or deleted, and new ones can
be added.  You can also build a snapshot from scratch, by clicking on the New button, and changing
the parameters by hand.  The MIDI Event column is a popup menu, and the other parameters are
numericals.
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TTTThhhheeee    SSSSnnnnaaaappppsssshhhhooootttt    CCCCoooonnnnttttrrrroooollll    WWWWiiiinnnnddddoooowwww
The Snapshot Control Window serves two main purposes:  the creation and organization of
Snapshots and Sets, and as a field (called the Meta Control Pane) for mouse control to interpolate
between the Snapshots in a Snap Set.

Snapshots and Snap Sets

Creating New Snapshots

To create a new Snapshot in the Control Window, click on one of the four Snapshot Name menus in
the corners of the window.  You will see a list of all the snapshots you have created, plus the option
to create a new one.  Selecting New will create a new Snapshot in the Snapshot Library, reflecting
the current MIDI state.

Modifying Existing Snapshots

If you want to completely rewrite a snapshot you have already created, rather than the slow process
of working in the Snapshot Editor, you can simply overwrite it in the Control Window.  To do so,
select the Snapshot you want to overwrite in one of the Snapshot Name menus, and Shift-Click on
the adjacent Current Snapshot button.

Creating Snap Sets

A Snap Set is a set of four Snapshots.  Only one Snap Set can be active at any one time.  There are
128 slots for Snap Sets in a Setup.  By default, they all contain Snapshot number 1, Empty
Snapshot (this is why you don’t want to change that snapshot).  Creating a snap set is as simple as
selecting a snapshot for each of the four corners of the Meta Control Pane.  You can scroll between
Snap Sets using the Number numerical at the top of the window.  The default names of the Snap
Sets are Snap Set 1-128, but these can be changed in the Name numerical.
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The Meta Control Pane
The main pane of the Snapshot Control window is the Meta Control Pane.  Clicking or click-dragging
the mouse in this area will interpolate between the continuous MIDI values in the 4 Snapshots of the
Snap Set.  The four curved lines indicate the area in which a particular Snapshot will have an effect
on the interpolation.  For example, if you have the cursor in the upper-right corner of the Meta
Control Pane, you will have 100% of that snapshot, and 0% of the other three Snapshots, affecting
LiSa.  As you move the cursor diagonally and to the left, the influence of that Snapshot will fade,
until you reach the white curve closest to the opposite corner, at which point 0% of that Snapshot
will be part of the interpolation. Meta Control can also be done via MIDI, see below.

When interpolating between Snapshots,
either by mouse or by MIDI, only

continuous values, such as controllers,
pitchbend, and aftertouch, will be sent to

LiSa.  If the Snapshots contain Note On or
Program Change events, they will be

ignored.

NNNNooootttteeeessss    aaaannnndddd    PPPPrrrrooooggggrrrraaaammmm    CCCChhhhaaaannnnggggeeeessss
When you save a Snapshot, if any MIDI notes are currently on, the note on events will become part
of the snapshot.  These events, however, cannot be invoked using Meta Control.  To activate them
you must use either a MIDI or onscreen Snap Trigger, which immediately loads the Snapshot into
LiSa.  Note that if you have both note events and continuous controller events in a snapshot and
invoke it with a Snap Trigger, all the controller values jump directly to their new positions.  Any
controller values that are not in the Snapshot, however, will remain untouched. The easiest way to
use a Snap Trigger is by clicking on one of the Snap Trigger buttons in the Snapshot Control
window.  This will immediately activate any notes that were on when you made the snapshot.

When changing from one Snapshot to another, all active notes will be turned off unless:

� Sustain is turned on for the MIDI channel that contains the active notes, or

� The same note, with an identical velocity, is present in the new Snapshot.

UUUUssssiiiinnnngggg    MMMMIIIIDDDDIIII    wwwwiiiitttthhhh    MMMMeeeettttaaaa    CCCCoooonnnnttttrrrroooollll
All of the Meta Control possibilities you can perform with the mouse in the Snapshot Control window
can also be done using external MIDI.  You can assign two external controllers to imitate the
movement of the mouse in the Meta Control pane.  Two controllers are assigned to the x and y axes
of the pane.  (A joystick, if you have one, is an excellent controller for this purpose).  The four Snap
Triggers can be invoked using 4 MIDI notes of your own choosing.  To assign MIDI to Snapshot
controls, open the Lisa Settings window in the Global menu.
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Meta Channel.  Controllers or notes sent on this MIDI channel will affect the Meta Controllers.

Control X/Y.  These two controllers will set the x and y axes of the Meta Controller.

Inv.  If this box is checked, the control input will be inverted.  An input of 0 will be read as 127, and
vice versa.

Snap Triggers.  If LiSa receives one of these 4 notes, it will ‘snap’ all Meta Controller settings to
one of the four corner positions.
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AAAAppppppppeeeennnnddddiiiixxxx    1111::::     SSSSaaaammmmpppplllleeee

VVVVeeeeccccttttoooorrrrssss    aaaannnndddd    ttttiiiimmmmiiiinnnngggg

DDDDeeeeffffiiiinnnniiiittttiiiioooonnnn
When LiSa processes audio samples, they are not processed one at a time, but rather in a
chunk, which are all put through the system at once.  This chunk is called a sample vector.
The size of the sample vector will effect all aspects of timing in LiSa, including latency (the
time between you take an action and it actually comes out of the computer), modulator and
envelope timings, and the overall amount of the CPU’s time that LiSa uses.  Vectors are
always set in powers of 2, and in LiSa can range from 64 to 512 samples.

Every time a sample vector is processed, LiSa generates what is called an audio interrupt.
That means that everything else the computer is doing stops for a moment while the audio
is processed.  It also takes the processor some work to enter and exit interrupts.  The
frequency of this interrupt is equal to the sample vector size divided by the sample rate.  For
example, if the sample rate is 44.1 kHz, and the sample vector size is 64, an interrupt will
occur every 1.45 milliseconds.  LiSa’s scheduling is tied to this variable rate.

EEEEffffffffeeeeccccttttssss
What does all this mean? There is a general tradeoff between sample vector size,
responsiveness of your computer, and processor load.  It will affect different aspects of your
Setup in different ways.  All of these factors have to be taken into consideration when
choosing your vector size:

� Processor Load:  The smaller the sample vector size, the more strain processing
samples puts on your CPU.  The more interrupts per second, the more your
computer works to output one second of audio.

� Latency:  Since a smaller sample vector produces more, but shorter interrupts,
LiSa will be more responsive to input when the vector is smaller.  (This issue
becomes more important if you are using a soundcard.)

� Modulators and Envelopes:  These functions are both used to process soundfiles
in one way or another, and are thus part of the recipe of ingredients in the audio
output.  This means that they, like any other sound material, are processed in
sample vector-sized chunks.  Modulators and envelopes cannot do anything in a
shorter space of time than 1 sample vector.    For example, if an envelope is set to
its fastest attack speed (which would take place in one sample vector), that speed
would be 1.45 ms at a sample vector rate of 64, and 11.61 ms at a sample vector
rate of 512 (512/44,100=11.61).

This means that if you change your sample vector rate while you are in the process of
developing a Setup, you will have somewhat different behavior in your Setup, particularly
regarding the maximum speed of modulators and envelopes.  LiSa is designed to keep
these speeds as consistent as possible if you change vector sizes, but the fastest speed of
any modulator or envelope will always be dependent on the vector size. It will always be a
matter of balancing between all of the above factors to find the optimum settings for a
particular Setup.  The sample vector size is saved with your Setup, so each Setup you use
can have a different size, if you wish.
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CCCChhhhaaaannnnggggiiiinnnngggg    SSSSeeeettttttttiiiinnnnggggssss
You change the sample vector size for your Setup in the Audio Settings…. Dialog in the
Global menu.  It is the last item in the window:

If you are using an ASIO soundcard, you cannot change the Sample Vector size within
LiSa, you have to do it from the Control Panel for your device.  This can be accessed either
in your Control Panels folder (usually in the Apple menu) or by clicking on the Control Panel
Button in the Audio Settings window.  We have found that when using an ASIO device, 256
samples usually produces the best results.

CCCCttttaaaabbbbssss    aaaassss    MMMMoooodddduuuullllaaaattttoooorrrrssss

When LiSa processes sound, it does so in groups of samples.  This is known as the signal
vector size (SVS).  When you set the Modulation Rate to its maximum speed (127.00) what
that means is that the Parameter you are modulating is changed once every SVS samples,
or once per audio vector.  Thus, tables are non-interpolating between their SVS values
(except for volume and panning).  This has several effects to keep in mind when designing
tables for modulators:

The smaller the table, the faster the modulation rate.  If you want to maximize the
modulation rate, use the smallest table possible.  For example, if you want to modulate pitch
with a square wave, use a table with a domain of two, with the first value set to 0.000, and
the second to 127.000. The smallest SVS that can be set is 64. This means that a
modulator using the above Table and running at full speed (127.00) will change between the
two values every 64 / 44100 ~ 1.45 ms, resulting in a freq. of 689 Hz.

Modulation rate changes geometrically.  Every increment in the Speed numerical of the
Controller Edit window adds one to the number of audio vectors that are calculated before
moving on to the next value.  At a rate of 127.000, it is one vector.  At 126.000, it is two,
making it twice as slow, at 125.000 it is three, and so on.   All pre-built modulator tables
contain 16 values.

To make the low modulator speed independant of the vector size, the highest speed is
based upon an SVS of 64. This means that when you set the SVS to 128, modulator speed
settings higher than 64.00 won't give you higher speeds, since the maximum speed you get
now is twice as slow as with an SVS of 64. So ith an SVS of 512 your max. effective speed
is 16.00.

Just one more fact: the longest modulator cycle you can get is by using a Table of 512 units
long and a speed of 0.01. In this case it takes 2 minutes and 27 seconds to do one
complete cycle!
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AAAAppppppppeeeennnnddddiiiixxxx    2222::::    VVVVooooiiiicccceeee

AAAAllllllllooooccccaaaattttiiiioooonnnn

PPPPoooollllyyyypppphhhhoooonnnnyyyy    aaaannnndddd    VVVVooooiiiicccceeee    AAAAllllllllooooccccaaaattttiiiioooonnnn

Number of Voices
LiSa is designed to be able to play a maximum of 128 voices (sounded notes or sample
records) simultaneously.  The actual number of voices you will be able to get depends on
several factors:

•  The speed of your machine.

• The kinds of Zones you are using, as some are
more computationally expensive than others.

• Number of filters you are using.  Filters slow LiSa
down considerably.

• Playback Quality of your samples.  If you are using
Good playback quality, you will get more voices
than if you use Best. (Good quality will not be
available if you are using an ASIO soundcard.)

Sounding voices is naturally the most time-consuming task on the part of your computer’s
processor, so the faster the computer is, the more voices it can sound.  LiSa can make very
big demands on your computer’s CPU, and will even ‘steal’ processor time from other
programs in order to produces all the voices that are being demanded of it.  In a case when
you are using LiSa on a computer simultaneously running other programs (for MIDI control,
for example) problems could obviously develop.

LiSa formerly allowed you to set limits on the amount of CPU time it could use directly.  This
system has been changed somewhat in v. 2.5.

Now you set the maximum number of voices that LiSa can sound at any one time, in the
Lisa Settings dialog box. You may need to experiment a bit to determine the best number of
voices for your performance configuration.

Voice Priority
If the maximum number of voices is exceeded, LiSa follows a strict order in deciding which
voices will be sacrificed first.  They are given priority in the order below, with the ones
sacrificed first at the bottom of the list.  The number of voices being played does not affect
loading and saving soundfiles.  The Zones that are sacrificed last are listed first:

• Playback Zones (High Priority).  Playback Zones
can have their voice allocation prioritized into
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high or low priority.  A high priority Zone will
always take precedence over any other Zone,
and if any record tasks are called for, a low
priority Zone will be dropped first.  Note that this
means that if all voices that are playing are set to
high priority, you will not be able to record.

• Record Zones.  If you are using all available
voices for playing and try to record a new
sample, low-priority playback voices will always
be sacrificed to perform the record.  Also, to
record a sample requires two voices, so if your
maximum number of voices is 12 and you’re
using them all, when you activate a Record Zone,
you will have 10 still playing.

• Playback Zones (other than High Priority). All
other playback zones will always be dropped first,
starting from the one that has been playing the
longest.
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• 

AAAAppppppppeeeennnnddddiiiixxxx    3333::::    KKKKeeeeyyyybbbbooooaaaarrrrdddd

SSSShhhhoooorrrrttttccccuuuuttttssss

The shorcuts listed here are in addition to those visible in LiSa’s menus.  Keyboard shortcuts will exhibit
different behaviours depending on which window is topmost – keep this in mind if something unexpected
happens.

Key(s) Pressed When Topmost Window is: Result

Cmd - 1 any loads the selected Sample File
from the Sample Lib into the
Sample Buffer

spacebar Zone Editor Activates/deactivates current
Zone

Sample Editor Plays buffer or selection in
Sample Editor

Sample Library Plays selcted sample

Cmd-spacebar Sample Editor Records into buffer or selection in
Sample Editor

backspace Sample Editor Clears selection in Sample Editor

Assignment Window Clears visible Voice Layer

Pattern Library Clears selected Pattern

Sample Library Removes selected sample(s)
from Sample Library (but not from
your disk)

Snapshot Editor Removes selected MIDI event
from shapshot

Cmd-backspace Sample Editor Clear Sample buffer

Any letter key Sample Library Jumps to corresponding letter in
Library

Tab Toggles between normal and
tuning keyboard layout in
Assignment window

Caps Lock Toggles between normal
keyboard and Key Map active

s Toggles start/stop grabbing
output buffer

- Toggles sostenuto on visible
Voice Layer
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+ Toggles sustain on visible Voice
Layer

k Assignment window defaults to
quarter-tone scale

n Assignment window defaults to
chromatic scale

u Assignment window defaults to
unison (all notes have the same
pitch value)

Esc Resets audio engine.  Stops all
active voices.

Numbers (01-16) Makes the corresponding Voice
Layer visible in the Assignment
Window.  Note that for layers 1-9,
a leading zero is required.

Up  arrow Presets Select and load previous Preset

Sample Library Select previous sample file

Down arrow Presets Select and load next Preset

Sample Library Select next sample file

Left arrow All Editors Select previous Item

Right arrow All Editors Select next Item

Option-left arrow Sample Editor Nudge selection 22ms to the left
(start and endpoints)

Option-right arrow Nudge selection 22ms to the right
(start and endpoints)

Option-up arrow
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absolute region start, 55, 91
Activate Mode, 62

Advance Mode, 62, 73
in patterns, 67

ASIO Drivers
installing, 13

Assignment window
and control parameters, 86
and retuning the keyboard, 56

assigning keyranges, 54
Audio Drivers

configuring, 14
selecting, 14

Auto Save Recording, 74, 82

B

back and forth parameter, 59
Back and Forth playback mode, 94

Buffer
Output, 19, 84

Process, 20, 85
Sample, 9, 19, 40

Buffers

resizing, 19

C
controller editor, 86, 89
Copy Buffer Zone, 29

Copy Buffer Zones, 83
CPU Load, 17

CTab. See Tables

D
Dpt Parameter, 60

E
Env Parameter, 58

Envelope Followers
configuring, 17
using, 100

Envelopes, 52
Amplitude, 64

editor, 52
filter, 65

in Wavetable Zones, 61

F

Fdb parameter, 75
Filters, 64

function
definition, 9

Fuz Parameter, 59

G

Global Settings, 16

I
Inp Parameter, 75
Input Gain, setting, 17

K

keyboard
scale retuning, 56

Keyboard Shortcuts, 120
keyboard, computer, 105
Keyranges

definition, 23
deleting, 27

setting, 26

L

Len parameter, 55
Length, parameter, 27

Length, pattern parameter, 7, 45, 85, 92
Lev parameter, 58

Libraries, 34
Envelope, 52

Pattern, 66
Sample, 36
Table, 47, 98

Limit, 44
Load Sample Zones, 28, 77

Dynamic, 80
static, 77

Load Session Zone, 29
Load Session Zones, 82
Looping mode, 62

M

Meta Control
using, 113
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channel and voice control, 90
channels, 87

configuring, 15
connecting, 15

controller behaviors, 91
creating controllers, 90
enable/disable, 63

global settings, 16
mapping with CTabs, 27, 55, 97

MIDI monitor pane, 86
parameter control

overview, 86
processing, 102

virtual keyboard, 26
voice layers, 10, 87

MIDI Snapshots, 109

creating, 109
editor, 111

library, 110
Modulator

Running mode, 64
Mouse Control, 107
Mvr parameter, 55, 80

N

Normalize, 44
Numericals, 7

O
Offset, pattern parameter, 67

Once mode, 62
Output buffer

resizing. See Buffers, resizing
Output Buffer Rec Start, 84
Output Routing, 57

Ovd Parameter, 75
Overdub mode, 72

P

Pan
playback parameter, 58

Pattern modes, 59, 66

Pattern Select., 94
Pitch, 56

Scale tuning, 56
Pitch Bend, 20

Pitch Trackers, 101
Playback Mode, 59
Playback Quality, 33

Presets, 30
Process Buffer

resizing. See Buffers, resizing

Program Change message, 33

R
range

definition, 9

Recording, 45
auto save sessions, 74

from CD, 70
input level, 75

live, 36, 70, 95
record monitor, 75

threshold, 71
Rel. Start parameter, 17
Replace mode, 72

Res parameter, 60
Resonator, 60, 94

Restart Mode, 62

S

Sample buffer
loading samples into LiSa, 40

resizing. See Buffers, resizing
saving samples from, 41

Sample Editor, 41
copying tables from, 51

dragging samples to, 40
editing, 44
navigating in, 42

Sample Library, 36
sample region, 55

definition, 9
Sample Vectors, 115

samples. See also Sample Buffer, soundfile
Loading, 78
loading into LiSa, 45, 77

Scrub, 59
Sessions, 82, 83

Setups, 33
Snapshots, 43

Sostenuto, 98
Spiral Algorithm, 59

Spl Parameter, 59
Status Window

CPU use, 17

dragging samples to, 40
input level monitor, 75

MIDI monitor pane, 86
record monitor, 75

Sustain and sostenuto, 98
voices monitor, 76, 84

Step Mode, 62

in patterns, 67
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Stt parameter, 55
Sustain, 98

System Channel, 16
System settings, 16

computer, 13
LiSa, 16

T
Tables, 47

as modulators, 90
copying from Sample Editor, 51

function buttons, 49
Mapping MIDI with, 97
real-time control, 97

Wavetable Zones, 60
TOn parameter, 72, 75

TOn/TOf parameter, 71
Trigger mode, 62

V
Velocity, 58, 99

virtual keyboard
dragging samples to, 40

quick Zone creation from, 55
Voice Allocation, 63, 118

Voice Priority, 118
Voices monitor, 76

W
Wavetable Synthesis, 60

Z
Zone editor

Copy buffer pane, 84
load sample file pane

static, 77
play treatment pane, 58

Zone information pane, 24
Zone Parameter Control, 63
Zone Reset, 93

Zones
basics, 23

editor, 24
finding, 27

Functions, 28
playback, 54
quick creation, 55
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